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Certification

Hewlett Packard Australia Limited certifies
that this product met its published specifi-
cations at the time of shipment from the
factory. Hewlett-Packard (HP) further certi-
fies that its calibration measurements are
traceable to the extent allowed by the cali-
bration facilities of International Standards
Organization members.

Warranty

The HP Broadband Service Analyzer is war-
ranted against defects in materials and
workmanship. If HP receives notice of such
defects during the warranty period, HP
shall, at its option, either repair or replace
hardware products which prove to be
defective.

HP software and firmware products that
are designated by HP for use with a hard-
ware product, when properly installed on
that hardware product are warranted not
to fail to execute their programming
instructions due to defects in materials and
workmanship. If HP receives notice of such
defects during the warranty period, HP
shall repair or replace software media and
firmware which do not execute their pro-
gramming instructions due to such defects.
HP does not warrant that the operation of
the software, firmware, or hardware shall
be uninterrupted or error free.

If HP is unable, within a reasonable time,
to repair or replace any product to a condi-
tion as warranted, Buyer shall be entitled
to a refund of the purchase price upon
return of the product to HP.

For product warranties requiring return to
HP, this product must be returned to a
service facility designated by HP. Buyer
shall prepay shipping charges to HP (and
shall pay all duties and taxes) for products
returned to HP for warranty service. Except
for products returned to Buyer from
another country, HP shall pay for return of
products to Buyer.

Duration and Commencement of the
Warranty

The HP Broadband Service Analyzer hard-
ware has a three year return to HP Service
Centre warranty, commencing at delivery
date (type 7A).

The HP Broadband Service Analyzer soft-
ware and firmware has a 90 day, replace-
ment warranty commencing at delivery
date (type 3C).

Limitation of Warranty

The foregoing warranty shall not apply to
defects resulting from improper or inade-
quate maintenance by Buyer, Buyer-sup-
plied products or interfacing, unauthorized
modification or misuse, operation outside
of the environmental specifications of the
products, or improper site preparation or
maintenance.

THE WARRANTY SET FORTH ABOVE IS
EXCLUSIVE AND NO OTHER WARRANTY,
WHETHER WRITTEN OR ORAL, IS
EXPRESSED OR IMPLIED. HP SPECIFI-
CALLY DISCLAIMS THE IMPLIED WARRAN-
TIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.

Exclusive Remedies

THE REMEDIES PROVIDED HEREIN ARE
BUYER’S SOLE AND EXCLUSIVE REME-
DIES. UNLESS REQUIRED BY APPLICABLE
LAW, IN NO EVENT SHALL HP BE LIABLE
FOR DIRECT, INDIRECT, SPECIAL, INCI-
DENTAL, OR CONSEQUENTIAL DAMAGES
(INCLUDING LOSS OF PROFITS) WHETHER
BASED ON CONTRACT, TORT, OR ANY
OTHER LEGAL THEORY.

Restricted Rights Legend

Use, duplication, or disclosure by the U.S.
Government is subject to the restrictions as
set forth in subdivision (b)(3)(ii) of the
Rights in Technical Data and Computer
Software clause at 52.227-7-13. Hewlett
Packard Australia, 347 Burwood Highway,
Burwood East, Victoria, Australia.

Additional Information for Test and
Measurement Equipment

If test and measurement equipment is
operated with unscreened cables and/or
used for measurements on open setups,
the Buyer has to ensure that under operat-
ing conditions the Radio Interference Limits
are still met at the border of the Buyer’s
premises.

Disclaimer

Except where otherwise stated, the param-
eters described are warranted performance
specifications. Parameters described as
“typical” or “nominal” are supplemental
characteristics that provide a useful indica-
tion of typical, but non-warranted, perfor-
mance.
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Warnings

The following general safety precau-
tions must be observed during all
phases of operation, service, and
repair of this product. Failure to
comply with these precautions or
with specific warnings elsewhere in
this manual violates safety stan-
dards of design, manufacture, and
intended use of the product.
Hewlett-Packard Company assumes
no liability for the Buyer’s failure to
comply with these requirements.

Ground the equipment For equipment
having a protective ground terminal (Safety
Class 1), an uninterruptible safety ground
must be provided from the mains power
source to the product input wiring termi-
nals or supplied power cable.

DO NOT operate the product in an
explosive atmosphere or in the pres-
ence of flammable gases or fumes
For continued protection against fire,
replace the line fuse(s) only with fuse(s) of
the same voltage and current rating and
type. DO NOT use repaired fuses or short-
circuited fuse holders.

Keep away from live circuits
Operating personnel must not remove
equipment covers or shields. Procedures
involving the removal of covers and shields
are for use by service-trained personnel
only. Under certain conditions, dangerous
voltages may exist even with the equip-
ment switched off. To avoid electrical
shock, DO NOT perform procedures involv-
ing cover or shield removal unless you are
qualified to do so.

DO NOT operate damaged
equipment Whenever it is possible that
the safety protection features built into this
product have been impaired, either through
physical damage, excessive moisture, or
any other reason, REMOVE POWER and do
not use the product until safe operation can
be verified by service-trained personnel. If
necessary, return the product to a Hewlett-
Packard Sales and Service Office for service
and repair to ensure the safety features are
maintained.

DO NOT substitute parts or modify
equipment Because of the danger of
introducing additional hazards, do not
install substitute parts or perform any
unauthorized modification to the product.
Return the product to a Hewlett-Packard
Sales and Service Office for service and
repair to ensure features are maintained.

DO NOT clean with fluids
Doing so may make the equipment unsafe
for use.

Safety Symbols

Instruction manual symbol affixed to prod-
uct. Indicates that the user must refer to
the manual for specific Warning or Caution
information to avoid personal injury, or
damage to the product.

Protective conductor terminal indicates the
field wiring terminal that must be con-
nected to ground before operating the
equipment—protects against electrical
shock in case of fault.

Frame or chassis ground terminal—typically
connects to the equipment’s metal frame.

Earth (ground) terminal.

Alternating current (ac).

Direct current (dc).

Indicates hazardous voltages.

Wa r n i n g
Calls attention to a procedure, practice, or
condition that could cause bodily injury or
death

C a u t i o n
Calls attention to a procedure, practice, or
condition that could possibly cause damage
to equipment or permanent loss of data.

Indicates that antistatic precautions should
be taken.
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Avertissement

Cet appareil répond aux normes de la
“Classe de sécurité 1” et est muni d’un fil
de mise à la terre pour votre protection.

Pour prévenir les risques de choc élec-
trique, la broche de mise à la terre du
cordon d’alimentation ne doit pas être dés-
activée.

Restrictions d’utilisation

L’utilisateur se doit d’observer les mesures
de précaution énumérerais-dessous pour
toutes les phases d’utilisation, de service et
de réparation de cet appareil. Le fait de ne
pas s’y conformer équivaut à ne pas
respecter les mises en gardes spécifiques
contenues dans ce manuel et constitue une
violation des normes de sécurité relatives à
la conception, la fabrication et l’utilisation
prévue de cet appareil. La société Hewlett-
Packard n’assume aucune responsabilité
envers un client qui manquerait de se con-
former à ces exigences.

Mise à la terre

Afin de minimiser les risques de choc élec-
trique, le châssis et le cabinet de l’appareil
doivent être mis à la terre. L’appareil est
équipé d’un cordon d’alimentation muni
d’une fiche homologuée à trois lames, com-
patible c.a. La prise murale et la prise
femelle de la rallonge électrique doivent
respecter les normes de sécurité de la
“Commission Électrotechnique Internation-
ale” (IEC).

Environnement

Ne faites pas fonctionner cet appareil en
présence de gaz inflammables ou de
vapeurs dangereuses. L’utilisation de
n’importe quel appareil électrique dans ces
conditions constitue un risque élevé pour
votre sécurité.

Service et ajustement

Des “tensions dangereuses” résident dans
cet appareil. Par conséquent, le service et
l’ajustement doivent être effectué unique-
ment par une personne qualifiée.

Ne remplacez pas de composantes lorsque
le cordon d’alimentation est sous tension. Il
pourrait y avoir présence de “tension dan-
gereuses” même lorsque l’appareil est
déconnecté.

Manipulation du tube cathodique

Une manipulation brusque, ou le fait de
secouer l’appareil, peut provoquer le bris du
tube cathodique. L’implosion qui s’en suiv-
rait entraînerait la dispersion à grande
vélocité d’éclats de verre. Le retrait ou
l’installation du tube cathodique ne doit
être exécuté que par un technicien qualifié,
portant un masque et des gants de sécurité
homologués.

Service non autorisé

L’installation de pièces étrangères, ou tous
modification apportée à l’appareil sans le
consentement de Hewlett-Packard est
formellement interdit. Le fait de procéder à
de tels modifications sans autorisation
pourrait entraîner l’annulation de la garan-
tie de l’appareil ou de tout contrat de ser-
vice.

Pour un service et des réparations
autorisées, retournez l’appareil à un point
de vente et service Hewlett-Packard.

Symboles des sécurité

Attention (voir documents d’accompagne-
ment)

Le conducteur protectif indique que la prise
de terre doit être connectée avant d’utiliser
l’equipment—protège contre le choc elec-
trique en cas de faute.

Borne de terre

Borne de masse, châssis

Courant alternatif

Courant continu

Risque de choc electriques

WA R N I N G
Attire l’attention sur une procédure, une
pratique, ou des conditions qui peuvent
entraîner des blessures corporelles ou la
mort.

CAU T I O N
Attire l’attention sur une procédure, une
pratique, ou des conditions qui peuvent
endommager l’équipement.

Signale que des précautions antistatique
doivent étre prises.

ou
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DECLARATION OF CONFORMITY
According to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name Hewlett Packard Australia Ltd.

Manufacturer’s Address Australian Telecom Operation
347 Burwood Highway
Burwood East, 3151
Victoria, Australia

declares that the product:

Product Name Broadband Service Analyzer

Model Number HP E5200A

Product Options This declaration covers all options of the above product.

conforms to the following product specifications:

Safety EN 61010-1:1993 / IEC 1010-1:1990 + A1
CSA C22.2 No. 1010-1:1992
UL 3111-1:1994

EMC EN 55011:1991 / CISPR 11:1990 (Group 1, Class A 1)
EN 50082-1:1992

IEC 801-2:1991 4 kV CD, 8 kV AD
IEC 801-3:1984 3 V/m
IEC 801-4:1988 0.5 kV Signal Lines, 1 kV Power Lines

.

Supplementary Information This product herewith complies with the requirements of the Low Voltage
Directive 73/23/EEC and the EMC Directive 89/336/EEC.
This product uses high speed digital interfaces which are susceptible to
Electrostatic Discharge (ESD). ESD may corrupt received data.

1The product meets the listed specifications with interface pods
 installed in both ports.

Melbourne, Australia, December 5,1995
Issue 1

Graeme Cobb - Quality Manager

European Contact: Your local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department ZQ/
Standards Europe, Herrenberger Straße 130, D-71034 Böblingen, Germany (FAX +49-7031-14-3143)
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What is the HP Broadband Service Analyzer?

What is the HP Broadband Service Analyzer?

The HP E5200A Broadband Service Analyzer is a portable yet powerful tool
designed specifically to test broadband equipment, networks, and services. It
can be used by public and private network providers to

• test network equipment
• aid in equipment installation
• test interworking devices
• test end-to-end services

You can use the analyzer to test the physical, ATM, and AAL layers in network
traffic.

The analyzer’s user interface has four main components that provide most of
the tools you need to install, test, and support network equipment and
services:

• Link Monitor and Channel Monitor continuously measure the key
indicators of the health of the link or of a specific channel (VPI/VCI), and
display the information in an easy-to-read summary format.

• SMARTtests and predefined macros speed up the common and
routine tasks you need to perform when installing and testing network
equipment and services, and to ensure quality of service.

• Simulator gives you all of the tools you need to have manual control of
the transmit functions of the analyzer.

• Capture Viewer shows you details of captured traffic. You can
troubleshoot any fault in any level of the protocol stack, such as LAN
emulation, classical IP, and Frame Relay over ATM.

You can use the analyzer as a standalone test solution for dispatched testing in
installation, commissioning, or maintenance applications. You can also display
the user interface on any HP-UX workstation and connect the instrument to a
network for remote monitoring.
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Where to Find Information

The HP E5200A Broadband Service Analyzer comes with a comprehensive set
of paper and online documentation. Use the following table to determine
which documents you should use.

What is it? What does it do? Who is it for?

User’s Guide
Chapter 1
“Setting Up the
Analyzer”

contains instructions on
how to set up and install
the analyzer

users who are
responsible for the initial
setup and any
subsequent relocation
of the analyzer

User’s Guide
Chapter 2
“Using the
Analyzer”

provides an outline of
the most common
analyzer functions

users who want a quick
introduction to the
analyzer and its main
functions

User’s Guide
Chapter 3
“Using the
Online Help”

describes the types of
online help available

all users

User’s Guide
Chapter 4
“System
Administration”

provides an outline of
the most common
system administration
functions

all users
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Where to Find Information

User’s Guide
Chapter 5
“Standards and
Specifications”

lists the electrical,
mechanical, and
environmental
specifications

users who are
responsible for
connecting the analyzer
to other equipment

Online Help three help volumes—
User, Macro, and UPE
Compatibility—contain
information about, and
instructions for using,
the analyzer

all users

Quick Reference provides a brief overview
of the analyzer’s main
features and functions

all users

Setting Up the
Interface Pod
guides

a series of guides that
provide descriptions of,
and instructions for
installing, individual
interface pods

all users

Worldwide
Support card

provides information
about support, service,
and warranty

all users

Release Notice
(if relevant)

provides information
not available when this
guide was printed

all users

What is it? What does it do? Who is it for?
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The release 1.7 documentation, in PDF format, is included on the CD ROM that
contains the distribution software. This includes theRelease 1.7 Broadband
Network Analyzer User’s Guide. The files are in themanuals directory on the CD
ROM. This directory contains the following files.

File Manual
5200ug31.pdf Broadband Network Analyzer User’s Guide
5120ig1a.pdf Setting up the DS1DS3 Interface Pod
5121ig1a.pdf Setting up the E3 Interface Pod
5122ig1a.pdf Setting up the OC-3/STM-1 Optical Interface Pod
5123ig1a.pdf Setting up the STM-1 Electrical Interface Pod
5125ig1.pdf Setting up the E1 Interface Pod
5126ig1.pdf Setting up the J2 6.3 Mb/s Electrical Interface Pod
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Introduction

When you receive your HP Broadband Service Analyzer, you must perform
the following steps before you can use it:

• Unpack the analyzer.
• Connect the analyzer to a controlling computer.
• Switch on the analyzer.
• Prepare the analyzer for use.
• Insert the interface pods.
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To Unpack the Analyzer

When you receive your HP Broadband Service Analyzer, ensure you have
received the correct items by checking the contents of the package
against the packing list in each box within the packing carton.

Caution The external connectors on the analyzer and interface pods are
susceptible to electrostatic discharge (ESD). Handle the equipment with
the necessary care to avoid ESD damage during unpacking, installation,
and operation.

The analyzer can operate either standing up or lying flat. Use the
stabilizing feet if you want the unit to stand up.

Stabilizing feet

Carry handle

Connector panel

Power connector and
switch
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Analyzer Software

All of the required software is preinstalled. If you have the HP Broadband
Service Analyzer (E5200A), the application software is pre-installed on
the analyzer.

If you have the HP Broadband Service Analyzer with the notebook PC
(E5200A option 050), the application software is pre-installed on the
analyzer, and the following software is pre-installed on the notebook PC:

• analyzer software (as backup)
• interface pod software (as backup)
• online help
• MS-DOS (Ver. 6.2)
• Microsoft Windows (Ver. 3.1)
• PC-Xware (Ver. 2.1)
• Acadia/VxD (Ver. 2.2)
• Borland C++ (optional—supplied with the Broadband Series UPE

Conversion Toolkit p/n E5190A)

You will also receive a set of diskettes containing the PC based online help,
and/or a CD-ROM that contains the

• analyzer software
• notebook PC software
• PC based online help
• UNIX based online help

Caution When you receive your analyzer, you should make a complete backup of
the notebook PC hard disk. This will save you time in the future if you
ever have any problems with the notebook PC hard disk. For backup
procedures, refer to “To Back Up Files” on page 1-24.

Caution Do not load any non-analyzer related software on the notebook PC. This
may cause damage to the analyzer’s software.

You can also use the analyzer with an HP-UX workstation as the display
server.

The HP Broadband Service Analyzer is certified to operate only with the
supplied notebook PC or an HP-UX workstation. If you have any problems,
contact your local HP representative.
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Connector Panel at a Glance

Power LED Light emitting diode (LED) that indicates when power is supplied to the
analyzer.

Access LED Light emitting Diode (LED) that indicates when the analyzer is accessing
information from a network.

BITS Input for synchronizing the analyzer to a Building Integrated Timing Source
(BITS) or to a DS1 or E1 source.

Sync In Input for synchronizing the analyzer’s Data Clocks, Measurement System,
or Data Timestamp to external equipment or another analyzer.

Sync Out Output for synchronizing external equipment, or for synchronizing the Data
Clocks, Measurement System, or Data Timestamps of another analyzer to
this analyzer.

UTP Connects the analyzer to a 10BaseT (Ethertwist/TPE) Local Area Network.
When the analyzer is supplied with an Omnibook, the UTP port is used for
connecting the analyzer to the Omnibook.

AUI Attachment Unit Interface connector used with an external MAU (Medium
Attachment Unit) to allow connection of the analyzer to a variety of
different Local Area Networks.

Serial Port for connecting the analyzer to a Terminal using RS-232C serial
communications.

DC Out This output is not active.

BITS  Sync Out

Serial

AUI
(LAN) DC Out

Sync In UTP
(LAN)

Power
Outlet

Power On/Off
Switch

Power LED

Access
LED
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To Connect the Analyzer to a Computer

The analyzer is designed for both onsite and remote broadband testing
applications. The way in which you connect the analyzer to a computer
depends on whether you want to perform remote or local testing. You can
connect the analyzer as a

• standalone system (with a notebook PC)
• networked system
• remote system (using a modem)

Both the HP Broadband Service Analyzer and the supplied notebook PC
are pre-configured for all of these connections (except for network
specific configuration parameters). For a networked system, you will need
to record additional information. See “To Connect the Analyzer as a
Networked System” on page 1-10.

The default configuration for the analyzer is as follows:

The default configuration for the notebook PC is as follows:

Boot source Local Disk

Ethernet IP Address 10.0.0.1

Ethernet IP Netmask 255.255.255.0

Host IP Address 10.0.0.2

Host Gateway IP Address not used

SLIP IP Address 10.0.1.1

Ethernet IP Address 10.0.0.2

Ethernet IP Netmask 255.255.255.0

SLIP IP Address 10.0.1.2
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Warning For your safety, the power cord supplied with the analyzer has a

grounded plug. Always use the power cord with a properly grounded

mains power outlet to avoid electrical shock.

If you will be converting data captured by the analyzer into HP
Broadband Series Test System (BSTS) captured data files, you must
install the Data Conversion Utility (p/n E5200-10010). See the
Installing/Upgrading Software section in the HP BSTS System

Installation & Startup Guide.

After you have prepared the analyzer for use, back up the analyzer’s hard
disk to the notebook PC or workstation; then archive this data using
backup storage media. See “To Back Up and Restore Files” on page 1-23.

To Connect the Analyzer as a Standalone System

You should connect the analyzer as a standalone system for onsite
testing, for example, at an installation site or a monitoring point. There
are two ways you can connect the analyzer as a standalone system:

• point-to-point ethernet interface
• point-to-point serial interface

Normally, you would use the point-to-point ethernet interface. You can
use the point-to point serial interface as a backup connection when there
is a problem with the ethernet interface, or when you need to set up the
configuration parameters for a networked system. See “To Change
Configuration Parameters” on page 1-20.

The computer to which you connect your analyzer should only contain
the software specified in “Analyzer Software” on page 1-4.
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To Connect the Analyzer to a Point-to-Point

Ethernet Interface

Caution Make sure at least 3 cm of clear space is left between the analyzer
ventilation openings and other objects.

If there is a boot failure, the analyzer attempts to boot from the host
computer using the configured boot host, and analyzer IP address.

2 Connect the
network cable
(E5200-64005)
to the PCMCIA
LAN cable.

5 Connect the analyzer to a
mains power outlet.

3 Connect the analyzer to
the notebook PC using
the PCMCIA LAN cable.

4 Connect the AC adapter
to the notebook PC.

1 Connect the cross-
over cable
(E5200-64006) to
the network
cable (E5200A-
64005).



1-9

Setting Up the Analyzer
To Connect the Analyzer to a Computer

1
Setting Up the
Analyzer

To Connect the Analyzer to a Point-to-Point

Serial Interface

To Record the System Administration Information

After you have connected the analyzer, switch on the analyzer (see “To
Switch the Analyzer On and Off” on page 1-22); then use the system
administration functions of the analyzer to set the

• system administrator password (see “To Change a Password” on
page 4-6)

• required users (see User Online Help)
• date, time, and time zone (see “To Set the System Date, Time, and

Time Zone” on page 4-7)
• printer (see User Online Help)

1 Connect the analyzer to the
notebook PC’s serial
connector. If this cable is
not supplied, use cable p/n
24542U.

2 Connect the
analyzer to a mains
power outlet.



Setting Up the Analyzer
To Connect the Analyzer to a Computer

1-10

To Connect the Analyzer as a Networked System

You should connect the analyzer as a networked system when you want to
remotely monitor a network. By connecting the analyzer to a networked
system, you can use either the supplied notebook PC, or an HP-UX
workstation at a remotely controlled monitoring point.

To connect the analyzer as a networked system, you need to perform the
following steps:

1 Configure the notebook PC or workstation.

2 Configure the analyzer.

3 Connect the analyzer.

4 Test for network connectivity.

5 Install the online help (UNIX workstation only).

6 Record the system administration information.

To Configure the Notebook PC or Workstation

If you are connecting the analyzer to the notebook PC via your network,
use Acadia/Vxd to reconfigure the following parameters (assigned by the
system administrator):

• notebook PC hostname
• notebook PC IP address
• notebook netmask
• default router IP address
• analyzer’s IP address

If you are connecting the analyzer to a HP-UX workstation via your
network, complete the following steps:

1 Note down the workstation’s hostname and IP address. You will find
this information in the /etc/hosts file.

2 Add the analyzer’s hostname and IP address to your workstation’s
/etc/hosts  file.
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3 Note down the workstation’s netmask. You will find this information in
the /etc/netlinkrc file.

4 Note down your workstation’s default route. You will find this
information in the /etc/netlinkrc file.

To Configure the Analyzer

Before you connect the analyzer as a networked system, you must set up
the following configuration parameters:

To set up the configuration parameters for a networked system, you can
either

• use the Network Configuration utility—see “To Change Configuration
Parameters” on page 1-20

• set up the analyzer as a standalone system; then use the system
administration functions—see the User Online Help

Notebook PC UNIX Workstation

Boot source local disk local disk

Analyzer Ethernet
IP Address

This must match the analyzer’s IP
address that you recorded in
Acadia/Vxd.

This must match the analyzer’s
IP address you added to the
/etc/hosts  file.

Analyzer Ethernet
IP Netmask

This must match the notebook
PC’s ethernet netmask IP address
that you recorded in Acadia/Vxd.

This must match the netmask
IP address noted down from
your workstation’s
/etc/netlinkrc  file.

Boot Host IP
Address

This must match the notebook
PC’s ethernet IP address that you
recorded in Acadia/Vxd.

This must match your
workstation’s IP address as
indicated in the /etc/hosts
file.

Boot Host Gateway
IP Address

This must match the notebook
PC’s default router IP address that
you recorded in Acadia/Vxd.

This must match your
workstation’s default router as
indicated in the
/etc/netlinkrc  file.



Setting Up the Analyzer
To Connect the Analyzer to a Computer

1-12

To Connect the Analyzer

Note You can also connect the analyzer to a LAN using a Medium Attachment Unit (MAU).
An MAU cable is not provided with the analyzer.

2 Connect the
analyzer to a mains
power outlet.

1 Connect the analyzer to the LAN
using the UTP cable
(E5200-64005).
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To Test for Network Connectivity

If you have connected the analyzer to a workstation, do the following:

• Use the UNIX ping command to verify that the analyzer is up and
running on your network. The syntax of the ping command may vary
from site to site. See your system administrator or the UNIX online
man pages for more details. If you cannot ping to the analyzer, check
all of the cable connections and configuration parameters.

• Check that you have given xhost authority for the analyzer to connect
to your X-display. See your system administrator or the UNIX online
man pages for more details.

If you are using the notebook PC, click the Ping icon in the Acadia/Vxd
program group. Ping the notebook PC and the analyzer separately using
their hostnames.

To Install the Online Help

If you have HP-UX superuser permission, you can install the analyzer
help on an HP series 700 workstation running HP-UX 9.05.

1 Mount the CD-ROM onto your file system by typing:

/bin/mkdir /cdrom
/etc/mount <cdrom_device_file> /cdrom

See your system administrator if you are unsure of the CD-ROM device
file name.

2 Run the HP-UX update utility by typing:

/etc/update

The update utility Main Menu is displayed.

Note This installation modifies the following files:

• /etc/inetd.conf
• /etc/services
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3 Select “Change Source or Destination” by using the arrow keys to
highlight the option; then pressing either Enter or F4.

The Change Source or Destination window is displayed.

4 Select “From Tape Device to Local System” as the Update from Source
to Destination by using the arrow keys to highlight the option; then
pressing either Enter or F4.

The From Tape Device to Local System window is displayed.

5 In the Source field, type /cdrom/HELP/HYPHELP/HELP.PKG

6 Press F4.

The Main Menu is redisplayed.

7 Select “All Filesets on the Source Media” by using the arrow keys to
highlight the option; then pressing either Enter or F4.

The Select All Filesets on the Source Media window is displayed.

8 Select “Start Loading Now” by using the arrow keys to highlight the
option; then pressing either Enter or F4.

A message window is displayed asking you whether you want to “Start
loading filesets now?”

9 Type y.

The Loading Partitions and Filesets window is displayed. This window
indicates the progress of the installation.

The help package is installed in the /OPT/E5200A/  directory.

10 When the installation is complete, you should view the log file to check
for errors in the installation. At the # prompt type more

/tmp/update.log .

11 Errors are displayed at the end of the file. If there are errors, correct
the problem and reinstall the help.

12 Unmount the CD-ROM from your file system by typing:

cd /
/etc/unmount /cdrom
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13 To print help topics, set up the current printer for the help viewer
using the Printer Setup option in the File menu. For more information
see the How to use Help option in the Help menu in the help viewer.

To Record the System Administration Information

1 Switch on the analyzer (see “To Switch the Analyzer On and Off” on
page 1-22).

2 Log in to the analyzer using the following user name and password.

See “To Log In to the Analyzer” on page 2-11.

3 After you have connected the analyzer, use the system administration
functions of the analyzer to set the

• system administrator password (see “To Change a Password” on
page 4-6)

• required users (see User Online Help)
• date, time, and time zone (see “To Set the System Date, Time, and

Time Zone” on page 4-7)
• printer (see User Online Help)
• remote hosts (see User Online Help)
• routing details (see User Online Help)
• remote file systems (see User Online Help)

Note The HP Broadband Service Analyzer has two sets of default login information:

Note You must have the appropriate privileges to perform system administration
functions.

• User Name—root
• User Name—boomer

Password—rootpasswd
Password—broadband
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To Connect the Analyzer Using a Modem

You can use a modem (configured to no parity, 8 data bits, 1 stop bit) to
remotely access the analyzer from the notebook PC. You should use a
modem connection only to access the Tcl interface.

You can set up a modem connection using either:

• an external modem
• a PCMCIA internal modem

To connect the analyzer using a modem, complete the following steps:

1 If you are using the PCMCIA internal modem, change the COM port
assignments for the notebook PC.

2 Connect the analyzer.

3 Set the remote modem to auto answer.

4 Set up the modem connection.

5 Record the system administration information.

To Change the COM Port Assignment

1 From the Main program group, click the Control Panel icon.

2 Click the OmniBook icon. The OmniBook Configuration window is
displayed.

3 Click the Change button in the COM Port Assignments area. The Select
COM Port Assignments window is displayed.

4 Set the serial port to COM4 by clicking COM4 in the Serial Port
column; then click OK.
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To Connect the Analyzer

To Set the Remote Modem to Auto Answer

Set the remote modem (connected to the analyzer) to auto answer by
setting the S parameter zero (SO) to a value greater than zero. See your
modem’s user’s guide.

Note You can either connect the notebook PC’s serial port to an external modem, or you can
connect the PCMCIA internal modem directly to the telephone socket.

2 Connect the
analyzer to a mains
power outlet.

1 Connect the
analyzer’s serial
port to the modem
(RS-232C US/Euro
modem cable p/n
24542M—part not
supplied).

3 Connect the notebook
PC’s serial port to the
modem (RS-232C
US/Euro modem cable
p/n 24542M—part not
supplied), or connect
the PCMCIA internal
modem to the telephone
outlet.
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To Set up the Modem Connection

1 Double-click the Dialer icon in the Acadia/VxD program group.

The Ipswitch, Inc. SLIP/PPP Configure & Dial window is displayed.

2 Click the phone number (e5200a) in the Phonebook list; then click the
Dial button.

3 If required, change the baud rate. To change the baud rate, click the
Setup button on the Ipswitch, Inc. SLIP/PPP Configure & Dial window;
then select the required baud rate from the Speed pull-down list. The
analyzer SLIP baud rate must match this baud rate.

4 If required, change the remote phone number. To change the remote
phone number, select e5200a from the Phonebook on the Ipswitch, Inc.
SLIP/PPP Configure & Dial window, click the Setup button, then type
the new phone number in the Phone #: field.

To Record the System Administration Information

1 Switch on the analyzer (see “To Switch the Analyzer On and Off” on
page 1-22).

2 Log in to the analyzer via the SLIP connection using the following user
name and password.

See “To Log In to the Analyzer” on page 2-11.

Note The HP Broadband Service Analyzer has two sets of default login information:

Dialer

• User Name—root
• User Name—boomer

Password—rootpasswd
Password—broadband
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3 After you have connected the analyzer, use the system administration
functions of the analyzer to set the

• system administrator password (see “To Change a Password” on
page 4-6)

• required users (see User Online Help)
• date, time, and time zone (see “To Set the System Date, Time, and

Time Zone” on page 4-7)
• printer (see User Online Help)
• remote hosts (see User Online Help)
• routing details (see User Online Help)
• remote file systems (see User Online Help)

Note You must have the appropriate privileges to perform system administration
functions.

Note After you have logged out, you must disconnect the modem. To disconnect the modem

1 Double-click the Dialer icon in the Acadia/VxD program group. The Ipswitch, Inc. SLIP/PPP
Configure & Dial window is displayed.

2 Select e5200a from the Phonebook list.

3 Click the Hangup button.

The connection is now closed.
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To Change Configuration Parameters

You can change the configuration parameters for the analyzer and the
controlling computer using either

• the Network Configuration utility. Use this method of changing the
configuration parameters when you want to connect the analyzer as a
networked system. You must change the configuration parameters
before you connect the analyzer.

• the analyzer system administration functions. Use this method when
the analyzer is connected as a standalone system.

To Configure the Analyzer Using the Network

Configuration Utility

1 Double click the HP Analyzer Terminal over SLIP icon in the HP
Broadband Analyzer program group.

2 Switch on the analyzer and hold down the Enter key on the terminal
for five seconds until the HP Broadband Service Analyzer
Configuration menu appears. You must press the Enter key
immediately after turning on the power switch.

The keyboard on the remote workstation must be configured to auto-
repeat.

3 Type 2 to change the current boot parameters; then press Enter.

4 Record the configuration parameters for the analyzer.

5 Close the terminal window by pressing Ctrl-C.

6 Switch off the analyzer. You must reboot the analyzer after you have
changed the configuration parameters.

7 Disconnect the terminal from the serial port.

8 Connect the analyzer to the network (see “To Connect the Analyzer as
a Networked System” on page 1-10).
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To Connect a Printer to the Analyzer

You can print from the analyzer if a printer is connected to your
computer. The printer must be compatible with PCL 5. If the analyzer is
connected to a network, you can also print using a LAN printer (using
PCL 5).

Refer to the computer’s user’s guide for information on how to connect
the printer. See the system administration functions in the User Online

Help to set the current printer.
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To Switch the Analyzer On and Off

After you connect the analyzer to the computer, you can switch on the
equipment.

The analyzer takes approximately two minutes to run its self-tests and
switch on. While it is switching on, the Power LED flashes green, and if the
analyzer is booting from a PC or LAN, the Access LED flashes orange.
When the analyzer is on, the Power LED remains green and the Access
LED flashes orange intermittently. If the Power LED stays red, contact
your HP support representative.

To switch off the analyzer, switch off the power to the computer and the
analyzer. When you switch off, the analyzer performs a shutdown under
software control which makes sure all files are properly closed.

When you switch off the analyzer, the Power LED flashes green during
shutdown and then goes off.

Caution Make sure shutdown is complete before unplugging or removing the
power cables, or switching off power at the AC wall outlet.

1 Turn on the computer power switch.

2 Turn on the power
switch.
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To Back Up and Restore Files

When you use the HP Broadband Service Analyzer, you create files that
are stored on the analyzer’s hard disk. You should back up these files

• after you connect and change the configuration of the analyzer
• on a regular basis to safeguard against data loss

See the Acadia/VxD Installation, Overview and Command Reference

for more detailed information about how to NFS mount a file system.

When you first start the notebook PC, you should create a bootable
diskette in case there is a complete hard disk crash (see “To Create a
Bootable Diskette” on page 1-23). You should also backup the notebook
PC hard disk (see “To Back Up Files” on page 1-24).

To Create a Bootable Diskette

1 Place a formatted diskette in drive A.

2 At the C:\>  prompt, type sys A:

3 Copy the following files from the C:\DOS  directory onto the diskette:

• format.com
• msbackdb.ovl
• msbackdr.ovl
• msbackfb.ovl
• msbackfr.ovl
• msbackup.exe
• msbackup.hlp
• msbackup.ovl
• msbconfg.hlp
• msbconfg.ovl
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To Back Up Files

You should perform regular backups to ensure minimal loss of data if a
problem arises with the analyzer’s hard disk. You should back up the
analyzer’s hard disk to the controlling computer’s hard disk, then archive
the data to backup storage media. The backup storage media may be
either diskettes, tape, or a network storage device.

To Back Up Files from the Analyzer to a Notebook PC

1 Open the HP Broadband Analyzer program group within the Windows
Program Manager.

2 Open the NFS Client icon within the HP Broadband Analyzer program
group.

3 Set the Network Path to E5200A:\IDE

4 Set the Drive to G or any unused drive designator.

5 Click the Connect button. The current drive connection information
should now display E5200A:\IDE on G .

6 Click the Close button to close NFS Client.

7 Open the Windows File Manager.

8 Back up drive G to drive C by dragging and dropping the G:\usr

directory to the C:\ directory.

9 Rename C:\usr  to C:\usr_old .

10 Copy G:\usr  to C:\usr . This process will take approximately 1 hour.

See the MS-DOS User’s Guide and the Microsoft Windows User’s Guide

for more information.

To Back Up Files from a Notebook PC to Backup Storage

Media

Use the Microsoft Backup Utility in the Microsoft Utilities program group.
See the Microsoft Windows (Ver. 3.1) User’s Guide.
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To Back Up Files from the Analyzer to an HP-UX

Workstation

1 On the networked HP-UX workstation, NFS mount the analyzer file
system under the local workstation file system, using the following
command:

/etc/mount <E5200A IP address>:/IDE /<mount point>

2 Copy all files and directories under /<mount point>/  to your
workstation file system or a backup device.

To Restore Files

If any data is damaged or lost from the analyzer’s hard disk, you should
restore the latest version of the files that you have backed up.

To Restore Files from Backup Storage Media to a

Notebook PC

If the notebook PC boots, restore the files using the Microsoft Restore
Utility in the Microsoft Utilities program group. See the Microsoft

Windows (Ver. 3.1) User’s Guide.

If the Notebook PC Does Not Boot

1 Press F2 then F8.

2 Set the Boot From parameter to FDD. This allows the notebook PC to
boot from drive A.

3 Press F3 and insert the bootable diskette (see “To Create a Bootable
Diskette” on page 1-23) in drive A.

4 Switch the notebook PC off and then on again so that it can boot from
drive A.
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5 At the A:\>  prompt, type

format/s C:\

This command formats drive C as a system disk.

Caution All information on drive C is lost.

6 At the C:\ > prompt, type

mkdir C:\dos

This command creates a DOS directory on drive C.

7 At the A:\> prompt, type

copy msb*.* C:\dos

This command copies all of the MS backup program files to the C:\DOS

directory.

8 Type cd C:\dos  and press Enter.

9 Type msbackup  to start the backup/recovery program.

10 Follow the instructions on the screen to restore files from the backup
storage media.

To Restore Files from a Notebook PC to the Analyzer

1 Open the HP Broadband Analyzer program group within the Windows
Program Manager.

2 Open the NFS Client icon within the HP Broadband Analyzer program
group.

3 Set the Network Path to E5200A:\IDE

4 Set the Drive to G or any unused drive designator.

5 Click the Connect button. The current drive connection information
should now display E5200A:\IDE on G:

6 Click the Close button to close NFS Client.

7 Open the Windows File Manager.

8 Restore drive C to drive G by dragging and dropping the C:\usr

directory to the G:\  directory.
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9 Switch the analyzer power off for 5 seconds.

See the MS-DOS User’s Guide and the Microsoft Windows User’s Guide

for more information.

To Restore Files from an HP-UX Workstation to the

Analyzer

1 On the networked HP-UX workstation, NFS mount the analyzer file
system under the local workstation file system, using the following
command:

/etc/mount<E5200A IP address>:/IDE /<mount point>

2 Restore all files and directories from the workstation file system or
the backup device to /<mount point>/ .

To Reset the Notebook PC

To reset the notebook PC to the default configuration

1 Exit Windows.

2 At the DOS prompt, type cd \resetpc ; then press Enter.

3 At the c:\resetpc prompt, type resetpc;  then press Enter.

This utility resets the analyzer and the Windows configuration to the
default values. If the notebook PC had non-analyzer related software
loaded on it, the relevant program groups will not be displayed. The
software files, however, will remain on the notebook PC. The network
configuration for the analyzer also returns to the default values.

If the utility is corrupt or fails to restore the notebook PC to its factory
defaults restore the notebook PC hard disk backup (see “To Restore Files
from Backup Storage Media to a Notebook PC” on page 1-25).



Setting Up the Analyzer
To Insert or Remove an Interface Pod

1-28

To Insert or Remove an Interface Pod

Interface pods can be inserted or removed from the analyzer at any time.
The power does not need to be switched off. You insert an interface pod
when you initially set up the analyzer, and subsequently when you change
the type of line to be monitored.

Caution Handle the interface pod with extreme care to avoid electrostatic
discharge (ESD) damage during unpacking, installation, and operation.
The connectors on the front and back of the interface pod are susceptible
to ESD.

The analyzer uses high speed digital interfaces which are susceptible to
ESD. ESD may cause received data to be corrupted.

To Insert an Interface Pod into the Analyzer

1 Hold the interface pod with the front-panel connectors facing toward
you and the Hewlett-Packard logo facing upwards.

2 Insert the interface pod into Port 1 or Port 2 of the analyzer.

3 Push the interface pod firmly into the analyzer until the connectors are
properly seated. The clip on the base of the interface pod clicks into
place when the interface pod is fully inserted.

The analyzer automatically sets the transmit and receive parameters
according to the signal it receives from the interface pod. The port is
automatically configured for full duplex mode.
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Caution You must always have two interface pods inserted in the analyzer while
it is operating. If your operations require only a single interface pod,
insert the blank interface pod (provided with the analyzer) into the
other port.

The two interface pods are necessary to maintain a balanced airflow for
cooling of internal components and to comply with EMC emission
standards.

To Remove an Interface Pod

When you remove an interface pod, make sure you store it in a dust-free
location that meets the environmental requirements listed in the Setting

Up the Interface Pod guide. An electrostatic bag has been supplied for
storing each interface pod.

Note Before you use an optical interface pod, you should clean the optical connectors and
test cables. See the appropriate Setting Up the Interface Pod guide.

Note To avoid any possibility of eye damage, the laser is automatically turned off when you
insert or remove an optical interface pod.

Press on the clip underneath
the interface pod and firmly
pull the interface pod out of
the analyzer.
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To Troubleshoot the Analyzer

If the Power LED is Not On

❑ Check that the analyzer’s power switch is on.

❑ Check that the analyzer’s power cable is connected to the analyzer and
plugged in to the power outlet, and the mains power is on.

If the Power LED is Red When You Switch On the

Analyzer

If the Power LED flashes red, there is a hardware fault. The analyzer may
still start, however, it will not work properly (for example, you may only be
able to use one port). Return the analyzer to Hewlett-Packard at your
convenience.

If the Power LED is continuously red, there is a serious hardware fault.
Return the analyzer to Hewlett-Packard.

If the Analyzer Switches on Normally, but You Cannot

Display the User Interface

❑ Check that the LAN cable between the analyzer and the notebook PC or
workstation is properly connected.

❑ Check that the analyzer is correctly configured for the network.

❑ Check that the computer has only the software specified in “Analyzer
Software” on page 1-4 loaded. Other software may interfere with the
computer configuration. Restore the hard disk by either

• restoring the backup (see “To Restore Files from Backup Storage
Media to a Notebook PC” on page 1-25)

• using the reset facility (see “To Reset the Notebook PC” on
page 1-27)
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If the Controlling Computer has No Display

❑ Check that the controlling computer power switch is on.

❑ Check that the power cable is properly connected to the controlling
computer.

❑ Check that the brightness and contrast controls are correctly set.

❑ Check that the computer has only the software specified in “Analyzer
Software” on page 1-4 loaded. Other software may interfere with the
computer configuration. Restore the hard disk by either

• restoring the backup (see “To Restore Files from Backup Storage
Media to a Notebook PC” on page 1-25)

• using the reset facility (see “To Reset the Notebook PC” on
page 1-27)

If You Cannot NFS Mount the Analyzer File System

❑ Check that Nfsdw and Inetdw are running on the notebook PC. If they
are running, the icons will be displayed on the screen.

If You Cannot Print to the Connected Printer

❑ Check that the PC-Xware LPD is running on the notebook PC.

❑ Check that all printer cables are connected correctly.

If the Cables Do Not Fit the Sockets

❑ Check the Box Contents lists to confirm that you have the correct
equipment.

❑ Check that you are using the correct cables for each connection. Check
the part numbers on the cables against the part numbers in the diagrams
in this User’s Guide.
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If the System Failure Window is Displayed

❑ Contact HP Customer Support. Print the window and fax it to HP
Customer Support. See “To Print a Window” on page 1-33.

Note If you cannot access the analyzer after performing the required checks, refer to the
Worldwide Support card for information on how to obtain customer support.
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To Print a Window

To Print a Window from the Notebook PC

1 Ensure that the printer is connected.

2 Make sure the window you want to print has the keyboard focus.

3 Press Alt-PrtSc.

4 From the Accessories program group, click the Paintbrush icon to
open Paintbrush.

5 From the Edit menu, select Paste to copy the captured screen into
Paintbrush.

6 From the File menu, select Print; then click OK. If you want, you can
save the file using the Save option on the File menu.

The captured window will print on your default printer.

To Print a Window from an HP-UX Workstation

1 Make sure the window you want to print does not have any other
window in front of it.

2 In a shell window, type

xwd -out <file_name>

You must save and name the captured window file in order to print it.

The cursor turns into a cross hair.

3 Move the cursor over the window you want to save; then click the left
mouse button. The keyboard bell will sound three times.

4 Print the file using the xpr command. For example, to print to the
default LaserJet (PCL) printer, type the following in a shell window:

xpr <filename> | lp

If you want to specify a printer, add the -d<printer_name> command to
the end of the above string. See your HP-UX user’s guide for more
information.
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To Connect to the System Under Test

1 Before you connect to the system under test (SUT), ensure that

• the analyzer is connected to the controlling computer (workstation or
notebook PC)

• two interface pods are inserted in the analyzer, one of which may be a
blank pod

2 Connect the interface pod(s) to the SUT. Each interface pod has a
transmit and receive connector on its front panel that you use to
connect to the SUT. See the Setting Up the Interface Pod guides for
specific details relating to your interface pods.

Note If you are using an optical interface pod, ensure that the connectors on the front
panel and the test cables are clean. Refer to the appropriate Setting Up the Interface Pod
guide for more information.

Receive (Rx) Transmit (Tx)
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There are three system connection options:

• intrusive
• non-intrusive
• diagnostic

Intrusive System Connection

When you install or remove an intrusive system connection, it affects the
traffic on the link to which the analyzer is connected. Either you need to
take the link offline to make the connection, or you need to interrupt
traffic.

The test connections available for intrusive system are

• network element
• remote loopback
• in-line

The interface configuration options for an intrusive connection are

• full duplex
• receive loopback
• regenerator
• loop through

Network Element Test Connection

You can use the analyzer to transmit test traffic that passes through the
network element, then returns to the analyzer for analysis and
comparison with the originally transmitted test traffic.

A typical application for this type of connection is installing and
troubleshooting a single network element, for example, checking whether
the network element is performing according to its specifications. Use this
connection to monitor, capture, and transmit traffic.
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The network element connection is an out-of-service test, that is, the
system is not live. Use this connection to check things such as

• protocol transfer and conversion
• connection verification
• quality of service parameters
• policing mechanisms

Configure the affected port(s) for full duplex for the network element
connection. If you use the receive loopback configuration or the recovered
clock timing source, make sure the network element transmitter is
synchronized to an independent timing reference (to avoid problems that
may be caused by possible clock failure).

Remote Loopback Test Connection

The remote loopback test connection is an out-of-service test, that is, the
network is not live. The analyzer generates and receives all system traffic.

Port 1 Port 2

Equipment under test

Tx
Rx

Tx

Rx

Port 1

Tx

Rx
Equipment under test
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A typical application for this type of test connection is testing the
integrity of the system under test. The remote loopback test connection is
similar to the network element test connection in its uses. However, while
the network element connection tests a single element at a time, the
remote loopback connection tests all network elements in the loop. Use
this connection to monitor, capture, and transmit traffic.

The main uses for this type of connection are to test

• continuity
• mean cell delay
• loop cell loss

Typically, you use a network element test connection to test any new
element you add to the network. When the element passes all relevant
tests, you change to the remote loopback test connection, and test to see
what effect the new element is having on the other network elements in
the loop. You can also use this test to identify a problem with a system
that is offline.

Configure the affected port(s) for full duplex for this type of test
connection.

In-line Test Connection

The in-line test connection is an intrusive system connection. A typical
application for the in-line test connection is testing equipment when it is
being installed. Using this connection, you don’t need to complicate your
test with optical or electrical splitters and T-pieces.

The loop through interface configuration is another type of in-line test
connection.

Port 1 Port 2

Equipment under test

Tx
Rx

Tx
Rx
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When using an in-line test connection, configure the affected port(s) for a
full duplex, regenerator, or loopthrough interface configuration (according
to the type of interface pod installed).

The disadvantage of the in-line test connection is that you need to break
the link to install and remove the connection. Therefore, for networks that
are already running live traffic, it is better to use a non-intrusive system
connection, such as passive and T-piece test connections.

Non-Intrusive System Connection

A non-intrusive system connection does not affect the traffic on the link to
which the analyzer is connected. A non-intrusive system connection is
most useful because you can run in-service tests without interfering with
the live system traffic.

There are two test connections available for the non-intrusive system
connection:

• passive
• T-piece

The analyzer interface configuration options for a non-intrusive system
connection are full duplex and receive loopback.

Port 1 Port 2

Equipment under test
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Passive Test Connection

Some ATM switches have dedicated test access ports. All traffic from the
switch is transmitted through both the regular port and the dedicated test
port. Connecting the analyzer to the dedicated test port is completely
non-intrusive. This type of connection never interferes with live traffic,
even during set up.

When using a non-intrusive, passive connection, the interface
configuration of the analyzer is not important. The analyzer’s default
interface configuration is full duplex.

T-piece Test Connection

This is a type of non-intrusive test connection that requires a T-piece or
splitter already present at a cross-connect. However, it does steal some
power from the traffic being transmitted over the network, so the T-piece
or splitter should be as close as possible to the transmit source (where the
power is at its strongest).

• For electrical networks, using a T-piece or splitter is common practice.

• For optical networks, special optical splitters are available. Using a T-
piece is possible only if your switch or network supports it. (The
splitter can draw up to 10% of the transmitted power, which affects
the transmission distance.)

Port 1 Port 2

Equipment under test

Tx
Rx
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When using a non intrusive, T-piece connection, the interface
configuration of the analyzer is not important. The analyzer’s default
configuration is full duplex.

Diagnostic System Connection

A diagnostic connection does not affect the traffic on the link to which the
analyzer is connected. Use this connection when you want to test the
analyzer.

There are two diagnostic test connections available for the diagnostic
system connection:

• transmit loopback
• external loopback

You can connect any of the interface pods available with the analyzer in a
diagnostic system connection.

T-piece

Port 1 Port 2

Equipment under test

Tx
Rx

Tx
Rx
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Transmit Loopback Test Connection

Transmit loopback is both an interface configuration option and a test
connection.

Transmitted data is directed both out of the transmit connector and
internally (within the interface pod) to the measurement system.

The analyzer ignores external connections to the receive connector.

For E1 interface pods set for the transmit loopback interface
configuration, you can select either the BNC or RJ-48 (equipment, or line
connector) as the transmitting connector. For all other interface pods,
you can only transmit using the connector labeled Out.

External Loopback Test Connection

Typical applications for this type of connection include calibration, self-
testing, troubleshooting, and demonstrations. This is an out-of-service
test that runs independently of a network. The analyzer acts as both the
transmitter and receiver.

Port 1 Port 2

Equipment under test

Tx
Rx
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You can perform this test using either a single port with a single interface,
or across two ports using two interfaces of the same line rate and
configuration. For example, you can make an external loopback
connection across two ports, between two OC-3/STM-1 interfaces.

Use the external loopback connection to monitor, capture, and transmit
traffic.

Configure the affected ports for full duplex interface configuration for the
external loopback test connections.

Port 1 Port 2

Port 1 Port 2
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To Log In to the Analyzer

To start up the HP Broadband Service Analyzer from the notebook PC,
you must double-click the appropriate icon in the HP Broadband Analyzer
program group. You can display either the analyzer Graphical User
Interface, or the analyzer Command Line Interface.

If at any time you cannot log in to the analyzer, reboot the notebook PC by
pressing Ctrl-Alt-Del.

If you still cannot log in, refer to the Worldwide Support card for
information about how to obtain customer support.

To Log In to the Analyzer Graphical User Interface

Double-click one of the following icons in the HP Broadband Analyzer
program group:

Use this icon to start the HP Broadband
Service Analyzer with a PC connected
through a Local Area Network (LAN).

Use this icon to start the HP Broadband
Service Analyzer with a PC connected
through the serial port.

HP Analyzer

HP Analyzer
over SLIP
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The HP Broadband Service Analyzer Login window is displayed after you
double-click an icon.

The analyzer checks the information that you entered. If your user name
and password are correct, it starts a new session using the default
configuration and displays the analyzer’s main screen and Link Monitor. If
any of the information you entered is incorrect, the analyzer displays an
error message and prompts you to try again.

Note The HP Broadband Service Analyzer has two sets of default login information:

1 Type your user
name. You are
assigned a user
name by your
System
Administrator.

2 Type your
password.

3 Click OK.

• User Name—root
• User Name—boomer

Password—rootpasswd
Password—broadband
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If at any time you cannot log in to the analyzer, reboot the notebook PC in
one of the following ways:

• Press the Reset button underneath the PC.
• Press Ctrl-Alt-Del.

If you still cannot log in, refer to the Worldwide Support card for
information about how to obtain customer support.

To Log In to the Analyzer’s Graphical User Interface on

an HP-UX Workstation

1 Type xhost +<analyzer hostname>

2 Type telnet <analyzer hostname> 5200

The analyzer hostname is assigned by your system administrator.

The HP Broadband Service Analyzer Login window displays.

To Log In to the Command Line Interface

Double-click one of the following icons:

Use this icon to start the Command Line
Interface to the HP Broadband Service
Analyzer (see the Macro Online Help). The
terminal is connected through a Local Area
Network (LAN).

Use this icon to start the Command Line
Interface to the HP Broadband Service
Analyzer (see the Macro Online Help). The
terminal is connected through the serial port.

HP Analyzer
Terminal

HP Analyzer
Terminal over

SLIP
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The Command Line Interface Login window is displayed.

The CLI (Command Line Interface) accepts Tcl (Tool Command
Language) commands, not UNIX commands. Tcl is the scripting language
used in macros. Some commands you can use at the Tcl prompt (%) are

• help—show CLI information
• version—show the software version
• saf—start the System Administration functions
• reboot—reboot the analyzer
• exit—exit the CLI

See the Macro Online Help for information about how to use the
Command Line Interface.

To Read the Analyzer’s Main Screen

The analyzer’s main screen is the first screen displayed after you log in.
Link Monitor is shown for each active port. You can view either Link
Monitor or the Simulator for each port by clicking the appropriate tab.

1 Type your login name. You
are assigned a login name by
your System Administrator.

2 Type your password.
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A port is active as soon as an interface pod is inserted. The left side of the
screen displays information about port 1, and the right side of the screen
displays information about port 2.

The analyzer automatically configures itself when you first log in and
when you change an interface pod. You can change the configuration
settings if required. See “To Configure the Analyzer and Ports” on
page 2-18.

If you want to use the same configuration in the future but do not want to
re-enter all the session details, from the File menu choose Save Session.

To load a saved system configuration into the analyzer, from the File menu
select Restore Session.

Menu Bar.

Link Monitor.
See “To
Monitor the
Link
(Network)” on
page 2-20 and
“To Monitor a
Channel
(VPI/VCI)” on
page 2-26.

Help hints. See “Help Hint
Bar” on page 3-7.

Alarm and Error
Indicators. See
“To Monitor
Alarms and
Errors” on
page 2-28.

Simulator. See
“To Simulate
Traffic” on
page 2-44 and
“To Inject
Alarms and
Errors” on
page 2-48.

Tests. See “To
Run
SMARTtests
and Predefined
Macros” on
page 2-36.

Measurement Controls. Start, stop, or reset
the measurement system and analyzer
configuration. See “To Configure the
Analyzer and Ports” on page 2-18.
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To Log Out from the Analyzer

If you are logging alarms and errors when you log out, the analyzer
displays a message reminding you that you are still logging. When you exit
the analyzer, logging stops.

1 From the File
menu, select
Exit.

2 Click Yes.

or

1 Double-click
the Control-
menu box.
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If you are using a modem connection, you must disconnect the modem.

1 Double-click on the Dialer icon in the Acadia/VxD program group. The
Ipswitch, Inc. SLIP/PPP Configure & Dial window displays.

2 Select e5200a from the Phonebook list.

3 Click the Hangup button. The connection closes.

After you have logged out, switch off the analyzer. See “To Switch the
Analyzer On and Off” on page 1-22.
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To Configure the Analyzer and Ports

After you log in you must configure the analyzer for the type of test you
want to perform, then specify the ATM and physical layer configuration for
each port.

To Configure the Analyzer

1 From the Configure menu, select the appropriate port.

2 Select the required configuration option:

• Select full duplex for intrusive tests.
• Select transmit loopback for diagnostic tests.
• Select receive loopback for non-intrusive tests.
• Select regenerator for intrusive tests for optical interface pods.

The default configuration option is full duplex. These options are also
available from the Simulator.

To set the measurement system and the reference clock, see the User

Online Help.

To Configure a Port

The analyzer auto-configures each port after you switch on the power and
insert an interface pod, and when you click the Reset button on the main
screen. When you configure a port, the analyzer changes the reference
clock to match the configuration. You can configure the analyzer manually
to override the automatic settings.
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Caution You should reconfigure the ports only when the measurement system is
stopped. Reconfiguring the ports causes the measurements and some
data to be lost. A warning message appears when this occurs.

To Manually Configure Each Port

If you want to reset the configuration parameters to the default values
after you have changed them, click the Auto button. Clicking the Reset
button on the main screen also resets the port configuration parameters
to their default values.

2 Click the ATM tab;
then specify the ATM
configuration
parameters for the
port.

3 Click the Signaling
tab; then specify
the signaling
configuration
parameters for the
port.

1 Click the physical layer
tab; then specify the
physical layer
configuration parameters
for the port.
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To Monitor the Link (Network)

While the measurement system is on, the analyzer continuously measures
the key indicators of the health of the link, and displays that information in
an easy-to-read summary format. To start the measurement system, click
the Start button on the main screen.

Use Link Monitor to see overall trend information. It provides an overview
of what is happening in the link and highlights any abnormalities.

Information relating to the interface pod and the link for port 1 is shown
on the left side of the screen; information relating to the interface pod and
link for port 2 is shown on the right side of the screen. When one of the
ports is empty, the analyzer displays a message telling you that there is no
interface pod inserted in that port.

All measurements shown on Link Monitor are current. The analyzer
collects measurements every 100 ms. At the end of a sampling period of 3
to 5 seconds, it uses these measurements to calculate statistics; then
displays the statistics on the screen (set the update period on the Set
Measurement Period window).
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Link Monitor is divided into two main areas.

Link Summary

These graphs show you a summary of the condition of the link. You can
double-click each graph to enlarge it and see detailed information.

These measurements are current, and the values are updated in real-time
while you view the graph.

Link summary graphs

Channel summary
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10 Highest Mb/s Graph

The first link summary graph shows the ten channels in the link that are
using the largest amounts of bandwidth. When you click a bar in the graph,
the VPI and VCI are shown under the graph and the channel is highlighted
in the channel summary. When you double-click the graph to enlarge it,
the analyzer displays the following information:

• mean sample bandwidth
• maximum sample bandwidth
• long term average bandwidth

These measurements are updated at the end of the update period (as set
on the Set Measurement Period window). The top ten channels might
change at the end of an update period.

You can go to Channel Monitor from the enlarged graph by clicking a bar in
the graph to select a channel; then clicking the Monitor Channel button.

AAL Usage Graph

The second link summary graph shows what percentage of the traffic is
made up of each AAL type. This is based on the mean sample bandwidths
of all channels in the link. When you double-click the graph to enlarge it,
you get detailed information about each AAL type, including the usage
ratio and bandwidths.

The detailed AAL Usage graph shows the

• percentage of bandwidth used by each AAL type
• amount of bandwidth (in Mb/s) used by each AAL type

Null refers to channels of unknown AAL type.

Enlarged 10 Highest
Mb/s graph

Enlarged AAL Usage
graph
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Total Mb/s Graph

The third link summary graph shows the maximum sample bandwidth
usage over time. There is a vertical indicator on the right side of the
graph. You can click the graph to move the vertical indicator to different
positions and see what the bandwidth usage was at any time during the
previous 300 seconds (5 minutes). The bandwidth usage is shown under
the graph in Mb/s.

When you double-click the graph to enlarge it, the analyzer displays the
following information:

• maximum bandwidth available for the port (which is the maximum
value on the bandwidth axis for the graph)

• maximum sample bandwidth over the past 300 seconds (dark blue
line)

• mean sample bandwidth over the past 300 seconds (light blue line)

The gap between the maximum and mean sample lines is an indication of
how bursty the traffic is. The further apart the lines are the more bursty is
the traffic on the link.

At the start of each new update period (as set on the Set Measurement
Period window), the vertical indicator returns to the right side of the
graph.

Enlarged Total Mb/s
graph
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Channel Summary

The table at the bottom of Link Monitor is a summary of the first 1023
active channels (VPI/VCI) that the analyzer reads for each port (shown in
the order in which they were detected) and one user-selected channel
(selected through Channel Monitor). Above the table is the total number
of channels for each port that have been active during the current
measurement period.

To go to Channel Monitor and see detailed information about a specific
channel, select a channel by clicking on the row for that channel; then
click the Monitor Channel button.

The analyzer can monitor up to 1024 channels at a time. Any channels
over the 1024 limit are not shown in the channel summary. You can select
a specific channel on Channel Monitor that will display on the channel
summary as the 1024th channel.

AAL type.Virtual Path Identifier
(VPI) in decimal.

Display Channel Monitor
for the selected channel.

Capture data.

Virtual Channel Identifier (VCI)
in decimal.

Maximum sample bandwidth.
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To select a specific channel

1 Start Channel Monitor.

2 Click the Set Up button.

3 Type the VPI and VCI to set up a new channel.

4 Select either automatic decode or manual decode to set the PRBS
pattern or AAL type.

5 Click OK.

See also “To Monitor a Channel (VPI/VCI)” on page 2-26.
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To Monitor a Channel (VPI/VCI)

Channel Monitor displays a summary of bandwidth usage, alarms, and
errors over the past 300 seconds (5 minutes) for individual channels
within the link. It works together with Link Monitor, which gives you a
summary of up to 1024 active channels in the link. When you find a
channel of interest, or an error or abnormality in Link Monitor, you can use
Channel Monitor to look at specific channels in greater detail. Channel
Monitor is particularly helpful for solving protocol problems.

Channel Monitor analyzes the protocol stack running on the channel. It
shows the links between the layers, and what effects alarms or errors in
one layer have on other (higher) layers. It also provides graphs that show
the way the channel is working, which help to highlight any abnormalities.

All measurements shown on Channel Monitor are current. The analyzer
updates the measurements at the end of the update period (as set on the
Set Measurement Period window).

Start the Channel Monitor in one of the following ways:

• Select one of the channels shown in the channel summary in Link
Monitor; then click the Monitor Channel button.

• From the Monitor menu, select the required port; then select the
Channel option and enter the required VPI/VCI.

• Click the Monitor Channel button from the

❍ Simulator
❍ 10 Highest Mb/s graph
❍ AAL error summary
❍ OAM F5 flow alarm summary

Note If the analyzer receives a large number of errors for a channel, it detects that channel’s
AAL type as Null. If you want to monitor AAL statistics for that channel, you need to set up the
channel and set the AAL type manually.
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Channel Monitor collects and displays statistics after a channel is selected
using Link Monitor, or after a channel is specified on the Monitor Channel
window. When the statistics are available, Channel Monitor shows them
for the past 300 seconds. The analyzer starts collecting statistics as soon
as you select a channel, even if Channel Monitor is not displayed.

Note For AAL-3/4 SAR, ATM statistics for the entire channel are displayed; however, AAL
statistics are displayed only for the selected MID.

For AAL-3/4 channels with more than one MID, Channel Monitor AAL measurements are
available only after you select a specific MID. You can select a MID in the Channel Monitor
window only if you select to decode the channel manually as AAL-3/4 in the Set Up Channel
window.

The maximum sample
bandwidth during the past
300 seconds.

Select the VPI/VCI and MID
(for AAL-3/4) of the channel
you want to view.

Alarms and errors that
occurred during the past
300 seconds for each
protocol layer.

To display more detailed
information about a
particular layer, click one
of the protocol tabs. See
“To Monitor Alarms and
Errors on a Channel” on
page 2-31.

If required, select the
PRBS type for the channel.

Capture data from the
current channel.

If required, select the AAL
type for the channel.
The analyzer automatically
detects the AAL type.
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To Monitor Alarms and Errors

The analyzer can display a summary of the alarms and errors at both the
link and channel level.

You can select the way you want to view the error statistics using the pull-
down lists on the status screens. Select from the following options:

• Count—the number of times the error occurred
• Ratio—the number of errored cells or frames received as a ratio of all

cells or frames received
• Seconds—the number of one-second intervals that contain the error

For AAL-3/4 you can choose to view either SAR or CPCS statistics.

See the User Online Help (look up details of the individual alarms and
errors) to find out what the relationships between the different alarms or
errors mean. This tells you the probable cause for an alarm or error, which
can help you resolve network problems.

To Monitor Alarms and Errors on the Link

A row of indicators at the top of Link Monitor warns you when alarms and
errors occur within the link at the physical, ATM, AAL, and OAM levels.
The color of the indicator shows the status of the level.

An indicator can be either

• green to indicate that there have been no alarms or errors since the
start of the current measurement period

• red to indicate a current alarm or error
• orange to indicate that an alarm or error has occurred since the start of

the current measurement period but is now clear

You can click each indicator to go to a summary window to see information
about the alarms, errors, and measurements.
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The color assignments are the same as for the higher level (summary)
indicators.

Alarms of similar durations or errors with similar counts are usually
related.

Note If unexpected alarms and errors occur while you are using an optical interface pod, run
an external loopback test on the port to determine whether there is a problem with the
network, or with the test cables or connectors. If the problem is not in the network, clean the
optical connectors and cable connectors. See the appropriate Setting Up the Interface Pod
guide for instructions.

1 Click an alarm and
error status
indicator to
display the
summary window
for a specific
protocol layer.

2 Select to display
the errors as a
count, a ratio, or
seconds.
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The status windows display the following information:

• Physical Layer

❍ types of alarms and the number of one-second intervals that contain
each alarm (this is called “errored seconds”)

❍ a summary of errors displayed as seconds, count, or ratio

• ATM Layer

❍ types of alarms and the number of one-second intervals that contain
each alarm

❍ count and bandwidth of ATM cells
❍ a summary of errors displayed as seconds, count, or ratio

• ATM Adaptation Layer (AAL)

❍ affected channel (VPI/VCI) for each AAL type
❍ Sequence Number and Cell Loss errors for AAL-1
❍ CRC errors for AAL-3/4 and AAL-5
❍ number of affected channels

• OAM

❍ affected channel or path
❍ flow type (segment or end-to-end)
❍ the number of one-second intervals that contain AIS or RDI alarms
❍ number of affected F4 and F5 flows
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To Monitor Alarms and Errors on a Channel

Alarms and errors on a channel are displayed in Channel Monitor. To start
Channel Monitor see “To Monitor a Channel (VPI/VCI)” on page 2-26.

The summary shows details of the alarms and errors that occurred at each
layer. Click a tab for more information about ATM and AAL alarms and
errors.

Note If the analyzer receives a large number of errors for a channel, it detects that
channel’s AAL type as Null. If you want to monitor AAL statistics for that channel, you need to
set up the channel and set the AAL type manually.

Ensure you select the
Summary tab. Use
Channel Monitor to
interpret the effects of
the alarms and errors.
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On the summary Channel Monitor, look for

• alarms and errors in the lower protocol layers and see what effects
they had on the higher layers

• the bandwidth during the periods that alarms and errors occurred to
see whether the bandwidth was affected

On the protocol specific Channel Monitor, look for

• alarms of similar duration
• errors with similar counts

See also User Online Help

Note All alarms and errors that occur at the physical layer affect the ATM layer, and
might render all ATM statistics invalid.

Click a protocol tab to view
detailed information about the
alarms, errors, and other
statistics for a specific protocol.
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To Log Statistics

When you click the On button, the statistics you define are logged to the
specified file. Logging continues until you click the Stop button.

2 If required, append the new
statistics to the end of an
existing log file.

3 Specify whether
you want to log
predefined
statistics, user-
defined
statistics, or
both.

1 Specify the file to which you
want to log statistics.

4 Turn logging
on/off.



Using the Analyzer
To Log Statistics

2-34

To Print the Log File

Click the Stop button to stop logging statistics; then click the Print button
to send the contents of the log file to the default printer. You cannot print
the log file while you are still logging statistics.

2 Select the layer for
which you want to
display the statistics.

1 Select the port for
which you want to
display the
statistics.

3 Click one or more of
the available
variants.

4 Click Select.
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To View the Log File

Log files are formatted as straight text. You can view log files up to 32,000
bytes in size using the macro editor.

1 Click the Stop button in the Log window to stop logging statistics.

2 From the Macro menu, select Edit to display the macro editor.

3 Specify the name of the log file you want to view. The analyzer
displays the named log file in the editor window.
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To Run SMARTtests and Predefined Macros

The analyzer provides a number of SMARTtests and predefined macros to
help you perform routine tasks.

SMARTtests

Simply select a SMARTtest from the Test pull-down list at the top of the
main screen, change any default values you require, and click the Start
button. It’s as easy as 1, 2, 3; the analyzer does the rest.

If you are not sure which SMARTtest to run, see the User Online Help.
Help is available for all SMARTtests describing what each one does, who
should run it, and why and when to run it.

Make sure the analyzer is connected to the system under test, and the port
is configured for full duplex mode. Refer to “To Connect to the System
Under Test” on page 2-2.

1 Select the transmit and receive
connection for the SMARTtest.

2 Change the default values to run the
SMARTtest in the way you want.
You can change the criteria and
traffic profile; then re-run the
SMARTtest any number of times.

3 Click the Start button.
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Before the SMARTtest starts to run, the analyzer checks to make sure the
affected ports are configured in full duplex mode and that there are no
alarms present. If either of these conditions is not met, an error message
appears and the SMARTtest does not run.

The figure at the bottom of the window starts running to indicate that the
SMARTtest has started, and relevant details are shown on the window as
the SMARTtest runs. The SMARTtest continues to run until it completes
or fails, as specified by the pass criteria. To stop the SMARTtest before
completion, click the Stop button.

When the SMARTtest completes, the figure jumps up if the SMARTtest
passes, or falls down if it fails. The SMARTtest Results window also
appears indicating whether the SMARTtest passed or failed, and if
relevant, why it failed.

The analyzer automatically captures data for each SMARTtest. If the
SMARTtest fails, you might find this captured information useful for
diagnostic purposes.

Predefined Macros

Select the predefined macro you want to run from the Test pull-down list
at the top of the main screen, then click the Test button to play the
macro. The predefined macro window is displayed; showing any results or
output that the predefined macro produces.

If you are not sure which predefined macro to run, see the User Online

Help.

Note When you start and stop a SMARTtest, you also start and stop Link Monitor and
the analyzer’s measurement system.
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To Capture and View Data

You can capture real data from the link at any time and use it for testing
and analysis. The analyzer captures incoming data from one or more ports
at full line rates up to 155 Mb/s. Capture data when you want to analyze a
fault condition or see what the data actually looks like. For example, you
can capture data to

• look for protocol errors
• look at pre-trigger and post-trigger data to determine the possible

causes of a fault
• produce reports from captured, logged, and monitored data
• look for patterns in protocols not currently supported by the analyzer
• store data for offline analysis at another time

The analyzer’s data capture options let you choose

• the source of the data to capture, for example, data for a specific
channel or set of channels

• the IP address or subnet of the data to capture (if there is IP traffic on
the link)

• whether to capture from one or both ports
• the start/stop criteria for the capture

After capturing data, you can view it using the View Captured Data
window.
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To Capture Data

Display the View Captured Data window for a single port in one of the
following ways:

• From the Monitor menu, select the required port; then select the
Capture option.

• From Link Monitor, click a channel in the channel summary; then click
the Capture button.

• From Channel Monitor, click the Capture button.

• From the AAL error or OAM alarm summary, click the Capture button.

• From the Simulator, click the Capture icon.

To display the View Captured Data window for a multiport capture, from
the Monitor menu, select Multiport; then select the Capture option.
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If you are performing a multiport capture, repeat steps 2 to 5 for the
second port. For more detailed information, see the User Online Help.

1 Select whether
you want to
capture cells or
AAL-5 frames.

2 Select the type of
data you want to
capture.

Click the Patterns button
if you want to define a
capture pattern.

3 If required, select
the events to
start and stop
the capture.

Click the Triggers button if you want
to select interface pod capture
events to trigger the capture.

4 If required, select
to capture cells
that match a
specific pattern
only.

5 Start the capture.
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To View Captured Data

After you capture or load data, it is displayed on the View Captured Data
window. You can use this window to view different portions of the data,
and save it to a file using the Save option on the File menu.

Save your captured data files in the following directory:

/USR/E5200A/HOME/[USERNAME]/PDU

You can also use this window to load and view previously captured data.

Use the Hexadecimal to ASCII conversion table when analyzing PDUs and
byte values. See “Hexadecimal to ASCII Conversion” on page A-2.

Stop capturing data.

Continue capturing data after
you have stopped a capture.

Start capturing data.

Indicates the capture memory
capacity and current level.

Set up the data to
capture.

Indicates the
PDU/cell you are
currently viewing in
capture memory.
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To use Data Captured by the Analyzer on a BSTS

If you are using the analyzer on a series 400 or series 700 HP-UX
workstation, you can convert the Broadband Service Analyzer captured
data files into Broadband Series Test System (BSTS) data files.

Ensure that the Data Conversion Utility (p/n E5200-10010) is installed.
See the Installing/Upgrading Software section in the HP BSTS System

Installation & Startup Guide.

To convert the analyzer captured data files to BSTS data files

1 In a terminal window, type

cap2bsts [-in analyzer_file_name] -out BSTS_file_name

If the complete in or out file path is not specified, the default directory
$HOME/broadband/recordings  is used.

If you only type cap2bsts , information about converting data is displayed.
This information provides details of the conversion utility, such as version
number.

As the conversion progresses, messages are displayed indicating the
number of cells that have been converted. When all of the cells have been
converted, a message is displayed indicating that the file was successfully
converted.

When you convert data captured by the analyzer to BSTS format, the data
is converted to a stream of ATM cells.

2 Type bisdn_playback to display the BSTS Playback Recording
window.

3 From the File menu, select Open to display the Load Data window.

Note If you use the bisdn_test command, you cannot select the Open option from the File
menu in BSTS.



2-43

Using the Analyzer
To Capture and View Data

2
Using the Analyzer

4 Click the converted data file in the list; then click OK. The captured
data file is displayed on the BSTS Playback Recording window.

Note When you convert data captured by the analyzer to BSTS, you will lose the dates in
the timestamps
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To Simulate Traffic

The Simulator is like a toolbox, filled with all of the tools you need for
manual control of the transmit functions of the analyzer. Use the Simulator
to customize traffic and simulate actual traffic conditions; then transmit
the traffic into the system under test.

The types of traffic you can transmit include

• captured data
• Protocol Data Units (PDUs) and sequences
• predefined patterns
• timestamped data
• user-defined byte values (see “Hexadecimal to ASCII Conversion” on

page A-2)

Using the Simulator you can also simulate controlled alarms and errors
and inject them into the transmitted traffic, which lets you further test
your network. After transmitting the traffic, you can monitor its effect
using Link Monitor and Channel Monitor.

Display the Simulator by clicking the Simulate tab for the required port
from the main screen.

Note When the port from which you’re transmitting is configured in full duplex mode with a
recovered clock, clock errors may occur if the receiver signal is poor. To avoid errors, change
the clock to internal, or monitor the link and make sure you have a healthy input signal.

Note For optical interface pods, the laser is automatically switched off when you log in
to the analyzer. You must turn the laser on when you are ready to transmit traffic and inject
alarms or errors. When you are not simulating traffic, alarms, or errors, make sure the laser
is off.

To turn the laser on or off, either
• click the Laser On or Off button on the Simulator
• from the Simulate menu, select the required port; then select Laser On or Off
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Use the Simulate Traffic from Traffic Generator window or the Simulate
Traffic from Capture Memory window (shown on the following pages) to
simulate and transmit traffic. You display these windows in either of the
following ways:

• From the Simulate menu, select the required port; then select Traffic;
then select Traffic Generator or Capture Memory.

• From the main screen, click the Simulate tab for the required port to
display the Simulator; then use the pull-down list to select Traffic
Generator or Capture Memory; then click the Traffic icon.

Use Traffic Generator to transmit traffic, such as predefined patterns,
Protocol Data Units (PDUs), or sequences. Use Capture Memory to
transmit captured data that is currently in the capture memory. At the top
of both Simulate Traffic windows are On/Off buttons to turn traffic
transmission on and off.

Display the View
Captured Data window
to capture data. See “To
View Captured Data” on
page 2-41.

Display Channel Monitor.
See “To Monitor a Channel
(VPI/VCI)” on page 2-26.

Turn the laser on or off for
optical interface pods.

Display the Physical Alarms/ Errors
window to simulate physical layer
alarms, errors, or PLCP frameword
errors. See “To Inject Physical Layer
Alarms and Errors” on page 2-51.

Display the Protocol Alarms/ Errors
window to simulate AAL or ATM
errors, or OAM alarms or cell losses.
See “To Inject Protocol Layer
Alarms and Errors” on page 2-48.

Select the configuration
for the port. See “To
Configure the Analyzer
and Ports” on page 2-18.

Select to generate traffic or replay
captured data.

Display the Simulate Traffic window
to select the traffic to transmit.
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To Simulate Traffic from the Traffic Generator

Use the Hexadecimal to ASCII conversion table when editing PDUs and
transmitting byte values. See “Hexadecimal to ASCII Conversion” on
page A-2.

Note If you select single cells, when you click the Transmit On button a Transmit button
appears. Click the Transmit button to transmit a single cell.

3 Edit the encode
options for each
channel if required.

1 Select the
channels on
which you want
to transmit data.
Channel 0 is the
foreground
channel, and
channels 1—10
are background
channels.

2 Enter the VPI/VCI
for each channel.

5 Select to transmit data
continuously or as single
cells for the foreground
channel.

4 Set the traffic profile
and bandwidth for the
foreground channel.

6 Set the bandwidth for
the background channels.

7 Specify the type of
payload for each
channel.
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To Simulate Traffic from Capture Memory

2 Select the traffic
profile you want to
use. The currently
selected profile is
shown on the button.

View the contents of
the capture memory
or capture new data
from the link.

1 Select to transmit
continuously or as
single cells. If you
select single cells,
click the Transmit
button to transmit.

Click this button to
change the profile
(distribution and
bandwidth).



Using the Analyzer
To Inject Alarms and Errors

2-48

To Inject Alarms and Errors

The analyzer can generate the following types of alarms and errors:

• protocol layer alarms and errors
• physical layer alarms and errors
• frameword errors

You must be transmitting traffic to be able to inject alarms or errors.

For more details about simulating and injecting alarms and errors, see the
User Online Help.

To Inject Protocol Layer Alarms and Errors

The analyzer can generate the following protocol layer alarms and errors:

• ATM and AAL errors
• OAM alarms
• cell losses

Display the Protocol Alarms/Errors window in either of the following ways:

• From the Simulate menu, select the required port; then select Protocol
Alarms/Errors.

• Click the Simulate tab for the required port to display the Simulator;
then click the Protocol Alarms/Errors button.

Note For optical interface pods, the laser is automatically switched off when you log in
to the analyzer. You must turn the laser on when you are ready to simulate traffic, alarms,
or errors. When you are not simulating traffic, alarms, or errors, make sure the laser is off.

To turn the laser on or off, either
• Click the Laser On or Off button on the Simulator.
• From the Simulate menu, select the required port; then select Laser On or Off.
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To Inject OAM Alarms

1 Click the OAM Alarms
tab.

2 Enter details about
the type of alarm you
want to simulate
(either F4 or F5).

3 Click the On button to
start injecting OAM
cells, or click the Inject
button to inject a
specified number of
OAM cells.
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To Inject ATM and AAL errors

Watch the results of the injected alarms or errors. The numbers of errors
and OAM cells injected is shown at the top of the Protocol Alarms/Errors
window. If you are using an external loopback or transmit loopback mode,
you can also monitor the errors and alarms by watching the Alarm and
Error indicators at the top of the main screen.

5 Click the bits you
want to error.

6 Click the On button to
start injecting errors, or
click the Error On For or
the Error Off For button
to transmit errors for a
specified number of cells.

4 If required, select the
part of the cell to error.

3 Select the type of error.2 Select the
channel(s) on
which to simulate

1 Click the Errors tab.
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To Inject Physical Layer Alarms and Errors

The analyzer can generate physical layer alarms and errors, and
frameword errors.

Display the Protocol Alarms/Errors window in either of the following
ways:

• From the Simulate menu, select the required port; then select
Physical Alarms/Errors.

• Click the Simulate tab for the required port to display the Simulator;
then click the Physical Alarms/Errors button.

To Inject Physical Alarms

The number of alarms you can select at one time depends on the interface
pod installed.

1 Click the Alarms tab.

2 Click the On
button for
the alarms
you want to
inject.
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To Inject Physical Errors

The type of errors you can inject depends on the interface pods installed.

Watch the results of the injected alarms or errors. The number of alarm or
error cells injected is shown at the top of the Physical Alarms/Errors
window. If you are using an external loopback or transmit loopback mode,
you can also monitor the errors and alarms by watching the Alarm and
Error indicators at the top of the main screen.

1 Click the Errors tab.

3 Click the Inject
button each time you
want to inject a
single error.

3 Enter the rate at
which you want to
inject errors; then
click the On button
to start injecting
errors.

2 Select the type of
error to inject.

or
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To Inject Frameword Errors

You simulate frameword errors to stress the framing mechanisms of
network elements and ensure that they react correctly to the errors.

1 Click the
Frameword tab.

2 Click the bits you
want to error.

3 Click the On
button.
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To Use Macros

You can use the Broadband Service Analyzer to create macros. A macro is
a file that contains a list of actions required to perform a task. After you
create a macro, you can repeat the actions as many times as you want
simply by playing the macro. Macros are particularly useful for repetitive
tasks such as running a series of tests.

The analyzer also provides a number of predefined macros that you can
run to perform common tasks.

The macros you create can be used by others. For example, you can create
a macro that contains a complete network test plan, then distribute the
macro to technicians to ensure that they all use the same test plan.

The Broadband Service Analyzer macro environment includes the Tcl
scripting language. You can use this scripting language to enhance your
macro, for example, to add looping and program control instructions.
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To Create a Macro

3 Click the Stop
button to stop
recording the macro.

2 Click the Record button
and perform the
actions that you want
to record.

Click the Pause button to pause the
recording.
Any actions you make while the
macro is paused are not recorded.
Click the Record button to continue
recording the macro.

1 Type a name for your macro
file; then click OK.

Click the Open File button to
display the Select File window.

Click the Save Session button if
you want to save your session.
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To Edit a Macro

1 From the Macro menu, select Edit to display the Select File window.

2 Type the name of the macro that you want to edit, or select the file
from the list. The macro is shown in the Edit window.

3 Edit the macro to add functions, such as looping and procedure
control. See the Macro Online Help for information on macro
commands and functions.

4 From the Macro Editor’s File menu, select Save to save your changes.

5 Test your changes by playing the macro.

To Play a Macro

1 From the Macro menu, select Play to display the Select File window.

If you have recorded, edited, or played a macro since the last time you
logged in to the analyzer, the Play Macro window appears with the last
macro you accessed as the active macro. In this case, click the File Open
icon to display the Select File window.

2 Type the name of the macro file that you want to play, or select the file
from the list.

3 On the Play Macro window, click the Play button to start the macro.

If you want to pause execution of the macro, click the Pause button. To
resume playing the macro from where you stopped it, click the Start
button.

If you want to stop the macro before it finishes, click the Stop button.
Click the Play button to replay the macro from the start.
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To Install the Online Help

You should install the online help when you receive a new version of the
analyzer software, or if you are setting up the analyzer to use on a
networked system (see “To Connect the Analyzer as a Networked System”
on page 1-10).

To Install the Online Help on a PC

You can install the analyzer online help on any PC with Windows 3.1 or
higher.

1 Insert the Help for Windows diskette 1 (p/n E5200-10017) in drive A. If
you have a CD-ROM drive attached to the notebook PC, use the
supplied CD-ROM.

2 From the File menu, select Run.

3 Type a:\setup  to install the help files from the diskettes. Type
d:\help\win\setup  to install the help files from the CD-ROM.

4 Click OK.

Follow the instructions on the screen. After you restart Windows, three
help icons (one for each help volume), and a readme file icon appear in the
HP Broadband Analyzer program group.
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To Install the Online Help on a Workstation

If you have HP-UX superuser permission, you can install the analyzer help
on an HP series 700 workstation running HP-UX 9.05.

1 Mount the CD-ROM onto your file system by typing:

/bin/mkdir /cdrom
/etc/mount <cdrom_device_file> /cdrom

See your system administrator if you are unsure of the CD-ROM device
file name.

2 Run the HP-UX update utility by typing:

/etc/update

The update utility Main Menu is displayed.

3 Select “Change Source or Destination” by using the arrow keys to
highlight the option; then pressing either Enter or F4.

The Change Source or Destination window is displayed.

4 Select “From Tape Device to Local System” as the Update from Source
to Destination by using the arrow keys to highlight the option; then
pressing either Enter or F4.

The From Tape Device to Local System window is displayed.

5 In the Source field, type /cdrom/HELP/HYPHELP/HELP.PKG

6 Press F4.

The Main Menu is redisplayed.

Note This installation modifies the following files:

• /etc/inetd.conf
• /etc/services
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7 Select “All Filesets on the Source Media” by using the arrow keys to
highlight the option; then pressing either Enter or F4.

The Select All Filesets on the Source Media window is displayed.

8 Select “Start Loading Now” by using the arrow keys to highlight the
option; then pressing either Enter or F4.

A message window is displayed asking you whether you want to “Start
loading filesets now?”

9 Type y.

The Loading Partitions and Filesets window is displayed. This window
indicates the progress of the installation.

The help package is installed in the /OPT/E5200A/  directory.

10 When the installation is complete, you should view the log file to check
for errors in the installation. At the # prompt type more

/tmp/update.log .

11 Errors are displayed at the end of the file. If there are errors, correct
the problem, type rmfn  in a terminal window, then reinstall the help.

12 Unmount the CD-ROM from your file system by typing:

cd /
/etc/unmount /cdrom

13 To print help topics, set up the current printer for the help viewer
using the Printer Setup option in the File menu. For more information
see the How to use Help option in the Help menu in the help viewer.
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To Display the Online Help

The analyzer’s online help consists of three volumes:

• User Online Help which contains
❍ instructions for the most common tasks
❍ reference topics that provide background information for those tasks
❍ a glossary
❍ descriptions of all screens, windows, fields, icons, buttons and

messages (context-sensitive help)
• Macro Online Help which contains all of the information you need to

record, edit, and run your own macros
• UPE Compatibility Online Help which contains all of the information

you need to convert your HP Broadband Series Test System UPE
programs for use with the HP Broadband Service Analyzer

To display instructions on how to use the help system, select Using Help
from the Help menu on the main screen.

You can access help in a number of ways depending on the type of help
you require.

To Display Help Topics

Topics within help are organized into help folders. The Help Contents list
displays a menu of all help folders. Each help folder contains a number of
subtopics.

To display the Help Contents list, select either User, Macro, or UPE
Compatibility from the Help menu.

If you are using the notebook PC, you can also run the help viewer
independently of the analyzer. The HP Broadband Analyzer program
group contains three help icons—one for each help volume. To display a
help volume, double-click the appropriate icon.
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To Display the Help Version Details

Make sure that the version number of the help you are currently viewing
matches the version number of your HP Broadband Service Analyzer.

1 From the analyzer main screen Help menu, select the About the
Analyzer option to find the version number of your HP Broadband
Service Analyzer.

2 From within any of the help contents screens, click the book icon in
the top left corner to find the help version.

3 If the version numbers do not match, contact your HP representative
and arrange to get the version of the help that matches your analyzer.

To Display Context-Sensitive Help

Context-sensitive help describes the currently selected screen, window,
field, icon, or button. You can display context-sensitive help in the
following ways:

• Click the Help button that appears on many screens and windows to
get information about that screen or window.

• Press F1. If the cursor is on an entry field, you get help for that field,
otherwise you get the User Contents list.

• Press Shift+F1, or from the main screen Help menu, select Help on
Item to change the cursor into a question mark (?). Move the question
mark around the screen and place it on the item for which you want
help; then click the mouse. Use the Help on Item option to display
context-sensitive help for non-input fields.
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Help Hint Bar

The help hint bar at the bottom of the main screen displays a brief
description of the field, icon, button, or menu option over which the
cursor is currently positioned. Help hint information is available for both
entry and non-entry fields.

Help hint bar
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To Use the System Administration Functions

You can perform the following system administration functions:

• change a password
• set the system date and time
• upgrade software

If you have the required privileges, you can also perform one or more of
the following system administration functions:

• set LAN and bootstrap parameters
• manage remote host details
• re-initialize the hard disk
• manage routing details
• manage remote file systems
• manage printer information
• manage user details
• manage host details

These functions are, however, usually restricted to the system
administrator.

By default, the user name boomer and password broadband has full
access to all of the system administration functions. You can use the
manage user details option in the system administration functions to
restrict the access privileges for any user except root.

For more information about these functions, refer to the User Online

Help.

To Start the System Administration Functions

The system administration functions are started from the Command Line
Interface. You can access the Command Line Interface in the following
ways



4-3

System Administration
To Use the System Administration Functions

4
System
Adm

inistration

• click the HP Analyzer Terminal icon or the HP Analyzer Terminal Over
SLIP icon in the HP Broadband Service Analyzer program group

• remotely log in through a Telnet session (see the User Online Help)
• use the analyzer Graphical User Interface

To Start the System Administration Functions Using the

Graphical User Interface.

See the User Online Help for more information about logging into the
system administration functions.

1 Type saf.
2 Click Send.
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To Move Around in the System Administration
Functions

The first screen displayed in the system administration functions is the
System Administration Functions Main Menu. This menu displays a list of
all of the functions you have authorization to perform.

To select a function, type the number corresponding to the required
function; then press Enter.

All screens have an Exit option (0 on menus or ^ on screens). This option
takes you to the System Administration Functions Main Menu, or if you
are at the main menu, it takes you back to the Command Prompt window.
A Help option (?) is also available on all screens. This option gives
information about the task you are currently performing.

All screens, except menus, display the message Press Enter to confirm

details when you have completed all of the required information.

Many screens have a Cancel option (!) which you can use to clear a screen
when you make a mistake. The information that you entered is not
processed.
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If a screen has multiple entry fields, the fields are displayed one at a time.
You must complete one field and then press Enter to display the next
field. You cannot go back to a completed field after you press Enter; if you
need to change a field you must complete all fields again.

To Change a Completed Field

1 Type !

2 Press Enter to cancel the change and return to the previous menu.

3 Start again.

You must use a keyboard in the system administration functions, that is,
you cannot use a mouse to navigate.
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To Change a Password

Your password must be a minimum of 8 characters and no more than 40
characters. At least one of the characters must not be alphanumeric.

Follow your standard business practices for changing passwords. Make
sure your password is not easily recognizable, such as your name.

To select the Change Password option from the System Administration
Functions Main Menu, type 1; then press Enter to display the Change
Password screen.

1 Type your current
password; then
press Enter.

2 Type your new
password; then
press Enter.

3 Type your new
password again;
then press Enter.

4 Press Enter.
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To Set the System Date, Time, and Time Zone

When you first install the analyzer, the time and date are set to GMT. You
should change the time, date, and time zone to that of your location. If
you move the analyzer to a different time zone, reset only the time zone.
The analyzer automatically resets the time and date. You should, however,
check that the time and date have been set correctly.

To select the Set Date and Time option from the System Administration
Functions Main Menu, type 2; then press Enter to display the Set Date
and Time Menu. Use this menu to select how you want to set the time and
date.
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To Change the System Date and Time

If you need to change the system time and date, type 1 on the Change
Current Date and Time screen; then press Enter to go to the Change
Current Date and Time screen.

1 Type the date in the
format dd-mm-yy;
then press Enter.

3 Press Enter.

2 Type the time in the
format hh:mm:ss; then
press Enter.
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To Change the System Time Zone

To change the system time zone, type 2 on the Change Current Date and
Time screen; then press Enter to go to the Change Time Zone screen.

If the time zone you require is not on the list, you can create a new time
zone by typing a numerical offset from the standard time zone in the
Please enter the new time zone (select option 1-431) or

create a new time zone  field. Enter the offset in the form

std+/- hh:mm:ss.

You can also specify the daylight saving time. See the User Online Help

for more information about creating a time zone.

2 Type the number
corresponding to the
location for which you
want to set the time;
then press Enter.

3 Press Enter.

1 Scroll through
the list to find
the required
time zone
location.
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To Upgrade the Analyzer Software

There are two ways to upgrade the analyzer software when a new version
of the software is released:

• diskettes
• File Transfer Protocol (FTP) from a remote host using either floppy

diskettes or a CD-ROM

Before you upgrade the analyzer software, you should back up all of the
files on the analyzer hard disk. See “To Back Up and Restore Files” on
page 1-23.

After you have upgraded the analyzer software, you should upgrade the
analyzer online help (see “To Install the Online Help” on page 3-2).

To select the Upgrade Software option from the System Administration
Functions Main Menu, type 3; then press Enter to display the Upgrade
Software Menu.
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To Upgrade Software Using Diskettes

From the Upgrade Software Menu, type 1; then press Enter to display the
Upgrade Software Using Diskettes screen.

Press Enter. When you have correctly installed the software, the message,
Upgrade complete  appears.

If the upgrade does not work, the message Upgrade failed appears. If
you cannot reboot the system, that is, you cannot even access the
previous version of the software, restore the latest version of the software
from a backup. See “To Restore Files” on page 1-25.

Switch off the analyzer power for five seconds (see “To Switch the
Analyzer On and Off” on page 1-22).

Caution The upgrade does not take place until after you reboot the analyzer.

Log in to the analyzer (see “To Log In to the Analyzer” on page 2-11);
then back up the analyzer to the notebook PC to the c:\usr  directory
(see “To Back Up Files from the Analyzer to a Notebook PC” on
page 1-24).

1 Insert each
diskette
provided into
drive A on the
PC according to
the instructions
on the screen.

2 Press Enter.
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To Upgrade Software Using FTP

If you are using the Upgrade floppy diskettes

1 Create a directory on your notebook PC or workstation called
FTPIMAGE.

2 Copy the contents of the \E5200A\  directory from each Upgrade
diskette to the new FTPIMAGE directory.

From the Upgrade Software Menu, type 2; then press Enter to display the
Upgrade Software Using an FTP Site screen.

When you have correctly installed the software, the message, Upgrade

complete  appears.

If the upgrade does not work, the message Upgrade failed appears. If
you cannot reboot the system, that is, you cannot even access the previous
version of the software, restore the latest version of the software from a
backup. See “To Restore Files” on page 1-25.

Switch off the analyzer power for five seconds (see “To Switch the
Analyzer On and Off” on page 1-22).

Caution The upgrade does not take place until after you reboot the analyzer.

1 Type the hostname
of your FTP site;
then press Enter.

2 Type your user name
on the remote FTP
site; then press Enter.

3 Type your password
on the FTP site; then
press Enter. 5 Press Enter.

4 Type the path for the
installation software
(for example,
FTPIMAGE); then
press Enter.
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Log in to the analyzer (see “To Log In to the Analyzer” on page 2-11);
then back up the analyzer to the notebook PC to the c:\usr  directory
(see “To Back Up Files from the Analyzer to a Notebook PC” on
page 1-24), or to an HP-UX workstation (see “To Back Up Files from the
Analyzer to an HP-UX Workstation” on page 1-25).
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Standards

Communications Standards

ITU Rec. G.703 General Aspects of Digital Transmission Systems—Terminal Equipment
Physical/Electrical Characteristics of Hierarchical Digital Interfaces

IEEE 802.3 (1993) Information Technology—Local and Metropolitan Networks

ANSI/EIA/TIA-232-E (1991) Interface between Data Terminal Equipment and Data Circuit—
Terminating Equipment Employing Serial Binary Data Interchange

Bellcore TA-TSY-000378 Timing Signal Generator (TSG)
Requirements and Objectives

ITU-T I.356 B-ISDN ATM Layer Cell Transfer Performance

ITU-T I.361 B-ISDN ATM Layer Specification

ITU-T I.363 B-ISDN ATM Adaptation Layer (AAL) Specification

ITU-T I.371 Traffic Control and Congestion Control in B-ISDN

ATM Forum UNI 3.1 ATM User-Network Interface Specification—Version 3.1

ANSI T1.102 Digital Hierarchy—Electrical Interfaces
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Electrical Specifications

Power Requirements (Mains)

Parameter Nominal Minimum Maximum Notes

Power 450 VA

AC Voltage—low range 100-120 V −15% +10% auto voltage selection

AC Voltage—high range 200-240 V −15% +10% auto voltage selection

Frequency 47 Hz 63 Hz
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External Connectors

RS-232 Serial Port

Conforms to ANSI/EIA/TIA-232-E (1991).

Pin Number Function

1 DCD

2 RXD

3 TXD

4 DTR

5 Ground

6 DSR

7 RTS

8 CTS

9 R1

9876

54321
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Ethertwist LAN (RJ-45) UTP Connector

Conforms to ANSI/IEEE 802.3-1993.

Pin Number Function

1 TD+

2 TD−

3 RD+

4 Not used

5 Not used

6 RD−

7 Not used

8 Not used

1 2 3 4 5 6 7 8
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AUI LAN (AUI DB-15F) Connector

Conforms to ANSI/IEEE 802.3-1993.

Parameter Nominal Minimum Maximum

DC output—voltage rating 12 V 11.7 V 12.6 V

DC output—current rating 0.5 A

Pin Number Function

1 Ground

2 Control in +

3 Data out +

4 Ground

5 Data in +

6 Ground

7 Not used

8 Ground

9 Control in −

10 Data out −

11 Ground

12 Data in −

13 +12Vout

14 Ground

15 Not used

8
7

6
5

4
3 2

1

913
14

15

10
11

12
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BITS Input (RJ-45) Connector

Parameter Nominal Minimum Maximum Notes

T1 signal stream 1.544 MHz −25 ppm +25 ppm conforms to ANSI
T1.102

E1 signal stream 2.048 MHz −25 ppm +25 ppm conforms to ITU G.703

8/64 kHz composite
clock

64 kHz −25 ppm +25 ppm conforms to Bellcore
TA-TSY-000378

Transmit clock 1.544 MHz −25 ppm +25 ppm all 1’s signal stream
when locked to reference

Transmit clock 1.544 MHz −150 ppm +150 ppm out-of-lock condition

Maximum voltage; any
pin relative to pin 7

50 V

Pin Number Function

1 Receive A

2 Receive B

3 No connection

4 Transmit A

5 Transmit B

6 No connection

7 Ground

8 4.7 nF to Ground

1 2 3 4 5 6 7 8
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Sync In Connector (DE9P)

Parameter Nominal Minimum Maximum Notes

Reference frequency 1 MHz −25 Hz +25 Hz

Input duty cycle 45% 55%

Input voltage (Logic-O) 0 V 1.5 V

Input voltage (Logic-1) 3.5 V 5 V

Input current (Logic-O) 2 mA Vin<0.5 V

Pin Number Signal Type Function

1 CMOS input Reserved

2 RS232 Output Reserved

3 RS232 Input Reserved

4 CMOS input 1 MHz clock input

5 CMOS input Reserved

6 Ground Ground

7 Ground Ground

8 Ground Ground

9 Ground Ground

9 8 7 6

5 4 3 2 1
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Sync Out Connector (DE9S)

Parameter Nominal Minimum Maximum Notes

Reference frequency 1 MHz −25 Hz +25 Hz

Output duty cycle 45% 55%

Output voltage (Logic-0) 0 V 0.8 V |
OH≥−5 mA

Output voltage (Logic-1) 4 V 5 V |
OL≤5 mA

Pin Number Signal Type Function

1 CMOS Output Reserved

2 RS232 Input Reserved

3 RS232 Output Reserved

4 CMOS Output 1 MHz clock output

5 CMOS Output Reserved

6 Ground Ground

7 Ground Ground

8 Ground Ground

9 Ground Ground

6 7 8 9

1 2 3 4 5
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Timing and Frequency References

Parameter Nominal Minimum Maximum Notes

Internal reference
frequency

19.44 MHz −4.6 ppm +4.6 ppm stratum 3 source

External reference
frequency

1 MHz −25 Hz +25 Hz

Recovered clock
frequency

fo −25 Hz +25 Hz fo = port 1 or 2 interface
pod rate

BITS—T1 reference 1.544 MHz −25 ppm +25 ppm applied to BITS input
connector

BITS—8/64 kHz
composite clock
reference

64 kHz −25 ppm +25 ppm applied to BITS input
connector

E1 reference 2.048 MHz −25 ppm +25 ppm applied to BITS input
connector



5-11

Standards and Specifications
Foreground Traffic Generation

5
Standards and
Specifications

Foreground Traffic Generation

Traffic Loading

Parameter Nominal Minimum Maximum Notes

Frequency Range 10 b/s 149.76 Mb/s maximum for OC3/STM-1
optical interface pod

Step size 50 b/s

Accuracy ±15 b/s relative to line rate

Sequence length 1 cell 1500 cells

Distribution
accuracy—poisson

approximates a poisson
distribution for bandwidths
of less than 10% maximum

Distribution
accuracy—sawtooth

5% BWmax/BWmin=10,
Sequence length ≥ 500 cells

Distribution jitter—
constant or burst

−1 cell +2 cells offset from nominal
inter-departure time

Parameter Nominal Minimum Maximum Notes

Frequency range 5 kb/s 149.76 Mb/s maximum for OC3/STM-1
optical interface pod

Step size 5 kb/s

Accuracy 2 kb/s relative to line rate

Sequence length 1 cell fixed
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Error Generation

Measurement System

Parameter Nominal Minimum Maximum Notes

ATM PDU error—
burst length

1 PDU 63 PDUs Number of consecutive
errored PDUs. Applied to a
single VPI/VCI or all cells.

Parameter Nominal Minimum Maximum Notes

Measurement
duration

3 sec 72 hours
(3 days)

Sample period 100 ms −4.6 ppm +4.6 ppm locked to internal reference

Timestamp
accuracy

−4.6 ppm +4.6 ppm locked to internal reference

Timestamp
resolution

100 ns

Timestamp rollover
period

20 days 44-bit timestamp counter
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Capture and Playback System

Capacity

Playback

Parameter Nominal Minimum Maximum Notes

Capture memory per
port

1 MB 7 MB 1 MB reserved for
foreground traffic generation

Playback memory
per port

1 MB 8 MB

Parameter Nominal Minimum Maximum Notes

Frequency range 100 b/s 149.76 Mb/s maximum for OC3/STM-1
optical interface pod

Step size 100 b/s

Accuracy 25 b/s relative to line rate

Sequence length 1 cell 131072 cells length as captured

Distribution
accuracy—poisson

approximates a poisson
distribution for bandwidths
of less than 10% maximum

Distribution
accuracy—sawtooth

±5% BWmax/BWmin=10,
Sequence length ≥ 500 cells

Distribution jitter—
sawtooth

−1 cell +2 cells offset from nominal
inter-departure time
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Mechanical and Environmental Specifications

Physical

Temperature

For operating and storage temperature of the analyzer with a controlling
computer, refer to the specifications of the controlling computer.

Size 335 mm x 440 mm x 100 mm
(13.19 in x 17.32 in x 3.93 in)

Weight 6 kg nominal
(13.2 lb)

Parameter Nominal Minimum Maximum Notes

Operating Temperature 5°C
(41°F)

45°C
(113°F)

with two interface pods
installed

Storage Temperature −40°C
(−40°F)

70°C
(158°F)
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Humidity

Altitude

Analyzer with or without
notebook

Operating Humidity 15 to 90% relative humidity at
40°C maximum

Storage Humidity 90% relative humidity at 65°C
maximum

Parameter Maximum

Operating 4.6 km

Storage 4.6 km
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Hexadecimal to ASCII Conversion

The following table shows hexadecimal codes and their ASCII equivalents.
Use this table when editing PDUs and transmitting byte values.

• Hex Code 27 is an apostrophe
• Hex Code 2C is a comma

Hex ASCII Hex ASCII Hex ASCII Hex ASCII
20 [space] 38 8 50 P 68 h
21 ! 39 9 51 Q 69 i
22 “ 3A : 52 R 6A j
23 # 3B ; 53 S 6B k
24 $ 3C < 54 T 6C l
25 % 3D = 55 U 6D m
26 & 3E > 56 V 6E n
27 ‘ 3F ? 57 W 6F o
28 ( 40 @ 58 X 70 p
29 ) 41 A 59 Y 71 q
2A * 42 B 5A Z 72 r
2B + 43 C 5B [ 73 s
2C , 44 D 5C \ 74 t
2D - 45 E 5D ] 75 u
2E . 46 F 5E ^ 76 v
2F / 47 G 5F _ 77 w
30 0 48 H 60 ‘ 78 x
31 1 49 I 61 a 79 y
32 2 4A J 62 b 7A z
33 3 4B K 63 c 7B {
34 4 4C L 64 d 7C |
35 5 4D M 65 e 7D }
36 6 4E N 66 f 7E ~
37 7 4F O 67 g 7F ∆
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Default Acadia Configuration

Acadia/Vxd has the following default configuration values.

Host table

Domain name information

no default configuration

IP address

127.0.0.1 localhost

10.0.0.2 e5200apc

10.0.0.1 15200a

10.0.1.1 e5200a_slip

10.0.1.2 e5200apc_slip

IP address 10.0.0.2

Netmask 255.255.255.0

Default Router
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NFS Services

TCP/IP Services

User Authorization

no default configuration

c:\usr\e5200a

c:\e5200a

a:\e5200a

[X] File Transfer (FTP)

[X] Finger

[ ] Printing (LPD)

[X] Remote Command (REXEC)

[X] Remote shell (RSH)

[X] Telnet

[X] Trivial File Transfer (TFTP)
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Category Environment

etc c:\acadia\etc

_hostname e5200apc

term ibmpc

users guest

vt100cmap c:\acadia\etc\telnet.att

vt100kmap c:\acadia\etc\vtket.map
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A
AAL

monitor alarms and errors, 2-30
acadia configuration, default, B-2

domain name information, B-2
host table, B-2
IP address, B-2
NFS services, B-3
TCP/IP services, B-3
user authorization, B-3

alarms
inject, 2-48

physical, 2-51
protocol, 2-48

log, 2-33
monitor, 2-28

AAL, 2-30
ATM layer, 2-30
OAM, 2-30
per channel, 2-31
per link, 2-28
physical layer, 2-30

ASCII to hexadecimal conversion, A-2
ATM layer

monitor alarms and errors, 2-30
AUI LAN connector, 5-6

B
backup files, 1-23, 1-24

create a bootable diskette, 1-23
from a notebook PC, 1-24
to a PC, 1-24
to an HP-UX workstation, 1-25

BITS input connector, 5-7
BSTS conversion utility, 1-7

C
capture data, 2-38

convert to BSTS, 2-42
capture system specifications, 5-13
category environment default configuration, B-4
change a password, 4-6
change the COM port assignments, 1-16
change the system date and time, 4-8
change the system time zone, 4-9
Channel Monitor, 2-26
cleaning instructions, iv
configuration, acadia default, B-2
configure a port, 2-18
configure the analyzer, 1-11, 2-18

configure the notebook PC or workstation, 1-10
connect the analyzer, 1-12
connect the analyzer using a modem, 1-17
connect to the system unde test

instrusive, 2-3
connect to the system under test, 2-2

diagnostic, 2-8
external loopback, 2-9
transmit loopback, 2-9

intrusive
in-line, 2-5
network element, 2-3
remote loopback, 2-4

non-intrusive, 2-6
passive, 2-7
T-piece, 2-7

connector panel at a glance, 1-5
connectors, external, 5-4

AUI LAN, 5-6
BITS input, 5-7
serial port, 5-4
Sunc Out, 5-9
Sync In, 5-8
UTP LAN, 5-5

create a bootable diskette, 1-23

D
data

capture, 2-38
replay, 2-47
view captured data, 2-38

data conversion, 2-42
data conversion utility, 1-7
date and time, change, 4-8
default acadia configuration, B-2
default configuration

category environment, B-4
domain name, B-2
host table, B-2
IP address, B-2
NFS services, B-3
TCP/IP, B-3
user authorization, B-3

domain name default configuration, B-2

E
electrical specifications, 5-3

power requirements, 5-3
environmental specifications

altitude, 5-15
humidity, 5-15
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physical, 5-14
temperature, 5-14

error generation specifications, 5-12
errors

inject, 2-48
physical, 2-51
protocol, 2-48

log, 2-33
monitor, 2-28

AAL, 2-30
ATM layer, 2-30
physical layer, 2-30

ethernet interface, 1-8
external connectors, 1-5, 5-4

AUI LAN, 5-6
BITS input, 5-7
serial port, 5-4
Sync In, 5-7, 5-8
Sync Out, 5-9
UTP LAN, 5-5

external loopback test connection, 2-9

F
File Transfer Protocol

upgrade software, 4-12
foreground traffic generation specifications, 5-11
frameword errors, 2-53

inject, 2-51
FTP, See file transfer protocol

G
Graphical User Interface, 2-11

H
help

display, 3-5
context-sensitive, 3-6
glossary, 3-5
help topics, 3-5

install, 3-2
for PC, 3-2
for workstation, 3-3

help hint bar, 3-7
hexadecimal to ASCII conversion, A-2
host table default configuration, B-2

I
inject, 2-53
inject AAL errors, 2-50
inject alarms and errors, 2-48

frameword errors, 2-51

physical, 2-51
protocol, 2-48

inject ATM errors, 2-50
inject OAM alarms, 2-49
inject physical alarms, 2-51
inject physical errors, 2-52
inline test connection, 2-5
install online help, 3-2

PC, 3-2
workstation, 1-13, 3-3

interface pod
insert, 1-28
remove, 1-29
storage, 1-29

IP address default configuration, B-2

L
Link Monitor

10 Highest Mb/s graph, 2-22
AAL Usage graph, 2-22
channel summary, 2-24
link summary, 2-21
Total Mb/s graph, 2-23

log
print a log file, 2-34
view a log file, 2-35

log alarms and errors, 2-33
log errors, 2-33
log in to the analyzer, 2-11

Command Line Interface, 2-13
log measurements, 2-32

print a log file, 2-32
log out from the analyzer, 2-16

M
macro

create, 2-55
edit, 2-56
play, 2-56

main screen, 2-14
measurement system specifications, 5-12
measurements

log, 2-32
mechanical specifications, 5-14
modem

change the COM port assignments, 1-16
connect, 1-17
set, 1-17
set up the connection, 1-18

monitor
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alarms and errors, 2-28
AAL, 2-30
ATM layer, 2-30
OAM, 2-30
per channel, 2-31
per link, 2-28
physical layer, 2-30

channel, 2-26
link (network)

10 Highest Mb/s graph, 2-22
AAL Usage graph, 2-22
channel summary, 2-24
link summary, 2-21
Total Mb/s graph, 2-23

N
Network Configuration Facility, 1-20
network connectivity, 1-13
network element test connection, 2-3
network, monitor, See Link Monitor

NFS services default configuration, B-3

O
OAM

monitor alarms, 2-30
online help

install for workstation, 1-13

P
passive test connection, 2-7
password, change, 4-6
PC, reset, 1-27
physical layer

monitor alarms and errors, 2-30
power off, 1-22
power on, 1-22
power requirements, 5-3
predefined, 2-36
print

a window, 1-33
log file, 2-34

printer, connect to the analyzer, 1-21
program the analyzer, See macro

R
remote loopback test connection, 2-4
reset the PC, 1-27
restore files, 1-23, 1-25

from a PC, 1-26
from an HP-UX workstation, 1-27

from backup storage media, 1-25

S
serial interface, 1-9
serial port connector, 5-4
set the remote modem, 1-17
set up the analyzer, 1-2

change configuration parameters, 1-20
Network Configuration Facility, 1-20

connect a printer to the analyzer, 1-21
connect the analyzer as a networked system, 1-10

configure the analyzer, 1-11
configure the notebook PC or workstation, 1-10
connect the analyzer, 1-12
install the online help, 1-13
record the System Administration Information, 1-15
test for network connectivity, 1-13

connect the analyzer as a standalone system, 1-7
ethernet interface, 1-8
record the System Administration Functions, 1-9
serial interface, 1-9

connect the analyzer remotely (using a modem), 1-16,
1-17, 1-18, 1-19

connect the analyzer to a computer, 1-6
connect the analyzer using a modem, 1-16, 1-17

change the COM port assignments, 1-16
record the System Administration Functions, 1-18
set the remote modem, 1-17
set up the modem connection, 1-18

disconnect a modem, 1-19
interface pods, 1-28

insert, 1-28
remove, 1-29

power off, 1-22
power on, 1-22

set up the modem connection, 1-18
simulate traffic, See traffic, simulate
SMARTtests

predefined macros
macro, 2-36

software
preinstalled, 1-4
upgrade, 4-10

diskettes, 4-11
File Transfer Protocol, 4-12

specifications
capture system, 5-13
electrical, 5-3

power requirements, 5-3
error generation, 5-12
foreground traffic generation, 5-11
measurement system, 5-12
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mechanical and environmental, 5-14
altitude, 5-15
humidity, 5-15
physical, 5-14
temperature, 5-14

timing and frequency references, 5-10
traffic loading, 5-11

Sync In connector, 5-7, 5-8
Sync Out connector, 5-9
system administration functions, 4-2

change a password, 4-6
navigate, 4-3, 4-4
select, 4-4
set the system date, time, and time zone

change the system time zone, 4-9
start, 4-2
system date, time, and time zone

change the system date and time, 4-8
upgrade software, 4-10

diskettes, 4-11
File Transfer Protocol, 4-12

system date, time, and time zone, 4-7
system under test, connect, 2-2

diagnostic, 2-8
external loopback test connection, 2-9
transmit loopback test connection, 2-9

intrusive, 2-3
in-line test connection, 2-5
network element test connection, 2-3
remote loopback test connection, 2-4

non-intrusive, 2-6
passive test connection, 2-7
T-piece test connection, 2-7

T
TCP/IP default configuration, B-3
test for network connectivity, 1-13
time zone, change, 4-9
timing and frequency reference specifications, 5-10
T-piece test connection, 2-7
traffic

capture, 2-39
simulate, 2-44

capture memory, 2-47
traffic generator, 2-46

view captured traffic, 2-41
traffic loading specifications, 5-11
transmit loopback test connection, 2-9
troubleshooting the analyzer, 1-30

print a window, 1-33

U
unpack the analyzer, 1-3
upgrade software

diskettes, 4-11
File Transfer Protocol, 4-12

user authorization default configuration, B-3
UTP LAN connector, 5-5

V
view

log file, 2-35
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